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.  
Edition Notices

This edition notice provides important information regarding the documentation for version 
5.0 of the CoolSign Digital Media Network product. Later releases are intended to be 
backwards-compatible, but may introduce new functionality not addressed in this content. 
Likewise, other product documentation may describe functionality not addressed here that 
will become available in later releases. Please consult with Haivision Systems, Inc. or its 
authorized representatives to ensure compatibility.

Copyright

© 2006-2013 Haivision. All rights reserved.

Title: CoolSign Network Manager User’s Guide 
Document Number: HVS-ID-UG-CS-NM
Version Number: 5.0

This publication and the product it describes contain proprietary and confidential informa-
tion. No part of this document may be copied, photocopied, reproduced, translated or 
reduced to any electronic or machine-readable format without prior written permission of 
Haivision. If this document is distributed with software that includes an end-user agree-
ment, this document and the software described in it, are furnished under license and may 
be used or copied only in accordance with the terms of that license. Except as permitted by 
any such license, no part of this guide may be reproduced, stored in a retrieval system, or 
transmitted, in any form or by any means, electronic, mechanical, recording, or otherwise, 
without the prior written permission of Haivision Systems Inc. Please note that the content 
in this guide is protected under copyright law even if it is not distributed with software that 
includes an end-user license agreement.

IMPORTANT
Network Manager is designed to access/play content which may have copyright 
restrictions. Acquiring licensing and re-distribution rights to restricted content shall be 
undertaken by the purchaser and not by Haivision. Please be sure to obtain any 
permission required from the copyright owner.

Licenses

This product is licensed under the MPEG-4 visual patent portfolio license for the personal 
and non-commercial use of a consumer for (i) encoding video in compliance with the 
MPEG-4 visual standard (“MPEG-4 video”) and/or (ii) decoding MPEG-4 video that was 
encoded by a consumer engaged in a personal and non-commercial activity and/or was 
obtained from a video provider licensed by MPEG LA to provide MPEG-4 video. No 
license is granted or shall be implied for any other use. Additional information including 
that relating to promotional, internal, and commercial uses and licensing may be obtained 
from MPEG LA, LLC. See http://www.mpegla.com.
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.  
Patents

CoolSign is covered by U.S. Patent Number 7,136,906 “System for Electronically Distrib-
uting, Displaying and Controlling the Play Scheduling of Advertising and Other Commu-
nicative Media” and Patent Number 7,228,341 “Method and System for Electronically 
Distributing, Displaying and Controlling Advertising and Other Communicative Media.” 
CoolSign may also be covered by one or more pending United States patent applications.

Trademarks

The Havision logo, Havision, Furnace, Hai1000, Makito, Barracuda, HaiPLAY, Piranha, 
InStream, Stingray, Torpedo, Kraken, Viper, Madra, and KulaByte are trademarks of 
Haivision. CoolSign is a registered trademark licensed to Haivision Systems, Inc. All other 
brand or product names identified in this document are trademarks or registered trademarks 
of their respective companies or organizations. 

Adobe, Flash Media Server, Flash, Flash Lite and Shockwave are trademarks of Adobe 
Systems Incorporated in the United States, other countries, or both. Apple, iPhone, iPad, 
iPod Touch are trademarks of Apple Incorporated in the United States, other countries, or 
both. 

All other trademarks and registered trademarks that appear in this content are the property 
of their respective owners. 

Disclaimer

The information contained in this document is subject to change without notice. Haivision 
assumes no responsibility for any damages arising from the use of this document, including 
but not limited to, lost revenue, lost data, claims by third parties, or other damages.

If you have comments or suggestions, please contact:

Haivision
ATTN: Information Development
4445 Garand
Montréal, Québec, H4R 2H9 Canada

Telephone: 1-514-334-5445

Email: info@haivision.com

While every effort has been made to provide accurate and timely information regarding this 
product and its use, Haivision Systems Inc. shall not be liable for errors or omissions 
contained herein or for incidental or consequential damages in connection with the 
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.  
furnishing, performance, or use of this material. The latest information available can be 
acquired from our web portal at:  http://www.haivision.com/download-center/ 

NOTE
A login is required to access the Haivision Download-Center.
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About This Book

Welcome to the CoolSign™ 5.0 User’s Guide for version 5.0. This documentation describes 
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.  
About Haivision™
About Haivision™

Haivision is a global leader in delivering advanced video networking, digital signage, and 
IP video distribution solutions. Haivision offers complete end-to-end technology for video, 
graphics, and metadata to help customers build, manage and distribute their media content 
to users throughout an organization or across the Internet. Haivision has specific expertise 
in the enterprise, education, medical/healthcare, and federal/military markets. 

Haivision acquired the assets of CS Software Holdings, LLC, including the CoolSign 
product technology, in November, 2010. This acquisition brought together Haivision's IP 
video streaming capabilities and CoolSign's feature-rich signage solution, with its sophis-
ticated technology to control, schedule, distribute, display, and monitor digital media.

Haivision is based in Montreal and Chicago, with technical centers in Beaverton, Oregon; 
Austin, Texas; and Hamburg, Germany. 

Audience

This user’s guide is focused towards an end-user, such as a content creator or network 
system administrator, who has a basic knowledge of telecommunications equipment, and 
IP/LAN networking concepts and terminology. 

Related Topics

• Reliability of Information on page 17

Reliability of Information

The information contained in this user’s guide has been carefully checked and is believed 
to be entirely reliable. However, as Haivision improves the reliability, function, and design 
of its products, the possibility exists that this user’s guide may not remain current.

If you require updated information, or any other Havision product information, contact:

Haivision
4445 Garand
Montréal, Québec, H4R 2H9 Canada

Telephone: 1-514-334-5445
Email: info@haivision.com

Or visit our website at: https://www.haivision.com.

Related Topics

• Obtaining Documentation on page 18
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.  
Document Conventions
Document Conventions

The following conventions are used throughout this document.

Typographic Conventions and Elements

Admonition Elements

The following admonition elements are used to advise and counsel that special actions 
should be taken.

Italics Used for the introduction of new terminology or for words being 
used in a different context, and for placeholder or variable text.

bold Used for strong emphasis.

Monospaced Used for code examples, command names, options, responses, 
error messages, and to indicate text that you enter.

Button Indicates a button or some object that you click.

> In addition to a math symbol, it is used to indicate a submenu. For 
instance, File > New where you would select the New option from 
the File menu.

... Indicates that text is being omitted for brevity.

TIP

Indicates highlights, suggestions, or helpful hints. 

NOTE
Indicates a note containing special instructions or information that 
may apply only in special cases.
CoolSign Network Manager Version 5.0, User’s Guide, Issue 01 19



.  
Document Conventions
IMPORTANT
Indicates an emphasized note. It provides information that you 
should be particularly aware of in order to complete a task and 
that should not be disregarded. IMPORTANT is typically used to 
prevent loss of data.

CAUTION
Indicates a potentially hazardous situation which, if not avoided, 
may result in damage to data or equipment, or minor to moderate 
injury. It may also be used to alert against unsafe practices.
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2. Using CoolSign Network Manager

CoolSign Network Manager (CNM) provides easy, customizable access to all the informa-
tion and data you need to manage a digital signage network. With CNM, you can import 
content, create channels and playlists, tune players, and monitor network transfers and 
status.

Topics Discussed

About Manager Pages . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  24

Working with Items in the Data Grid  . . . . . . . . . . . . . . . . . . . . . .  27

Selecting Items in the Data Grid . . . . . . . . . . . . . . . . . . . . . . .  27

Performing Context-Sensitive Actions on an Item  . . . . . . . . . . . .  27

Changing the Data Grid Layout  . . . . . . . . . . . . . . . . . . . . . . . . .  28

Sorting Columns  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  28

Grouping Columns  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  28

Resizing Columns . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  29

Changing which Columns are Visible  . . . . . . . . . . . . . . . . . . .  30

Reordering Columns  . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  32

Managing Views . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  32

Importing and Exporting Views . . . . . . . . . . . . . . . . . . . . . . .  32

Resetting and Restoring Default Views . . . . . . . . . . . . . . . . . . .  33

Searching for Items  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  33

Using the QuickBar  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  34

About the QuickSet Panel  . . . . . . . . . . . . . . . . . . . . . . . . . .  35

Using QuickSets  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  35

Using QuickSearches . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  36

Organizing QuickSets and QuickSearches . . . . . . . . . . . . . . . . .  37

Printing and Exporting Data  . . . . . . . . . . . . . . . . . . . . . . . . . . .  38

CNM is organized into different screens that allow you to view and manage different areas 
of your network:

Home Manager—Provides a high-level dashboard where you can quickly see 
the overall status and health of your network. Important alerts that may require 
your attention or management are displayed in the Alerts grid on the Home

               Manager, along with a log of all major actions that have been performed with
               CNM.
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About Manager Pages
Content Manager—Lets you view the entire repository of content available on 
your CoolSign network. You can import new content, modify numerous content 
properties that affect how the content is played back, retrieve the play history for 

content, and
               more.

Audio Manager—Similar to the Content Manager, but specialized for managing 
audio content only. You can import MP3 files directly into the Audio Manager 
without needing to run them through Content Wizard.

Data Table Manager—CoolSign uses data tables to provide dynamic data to 
content and scheduling expressions. With the Data Table Manager, you can 
manually create new data tables or input data into existing data tables.

Data Watcher Manager—(Optional) You can install the Data Watcher to 
provide a bridge between a data source and a CoolSign network. The Data Watcher 
can read data from various types of data sources, parse that data, and then import 

it into a CoolSign data table.

Channel Manager—Channels are the master schedules that you tune your 
players to. You can use the Channel Manager to create new channels and schedule 
content or playlists into channels. Once a channel is created, you can then use the 

Player Manager to tune players to your channel so they start playing the scheduled content.

Playlist Manager—Playlists are specialized sub-schedules that you can insert 
into channels. Playlists provide extensive flexibility in how you create your sched-
ules. You can use the Playlist Manager to create, edit, or delete playlists and to 

schedule content within the playlists.

Player Manager—Players are the nodes in your network that play back content 
on a display device. The Player Manager provides functionality to manage your 
players, including the ability to remotely configure players, divide a player into 

multiple regions, tune a player to a channel, and review the play history for a player.

Network Manager—Lets you see every node of your network and manage 
technical properties like software versions, bandwidth control, and configuration. 
Primarily intended for technical users, the Network Manager enables you to trou-

bleshoot network issues and take corrective action when necessary.

To navigate to a manager screen:

• Click the manager’s icon in the navigation bar on the left side of the screen, or

• Choose VIEWS > GO TO > and select the appropriate manager.

About Manager Pages

With the exception of the Home Manager, each of the manager screens share similar 
layouts and functionality. While the type of item that each screen manages differs, each 
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manager provides the ability to customize how your data is displayed and to organize the 
data in ways that make sense to your specific use of the digital media network.

About the Data Grid

The most important element in each manager is the data grid. The data grid displays the 
items available in your network in a grid-like table of rows and columns. The data grid is a 
powerful tool that can be used to organize and customize what information you see about 
each of the objects in your network.

About Local Storage and Silverlight

CoolSign Network Manager uses Microsoft Silverlight, which, by default, is limited to 1 
MB of local storage space. This space is used to cache thumbnail images, such as those 
displayed on the “Now Playing” screen. Silverlight should be configured to enable the use 

The quickbar gives 
you tools to quickly 
filter or view sets of 
items in the data grid. 

The data grid shows the 
available items for each 
specific manager. 

 You can right-click an 
item to display a con-
text-sensitive popup 
menu of actions for 
the item. 

Change the view of 
the data grid from 
this combobox. 

The status bar tells you how 
many items you have 
selected in the data grid plus 
other useful information.

Provides instant and 
advanced search 
capabilities.
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of local storage. To verify this, launch the Microsoft Silverlight Configuration utility and 
make sure “Enable application storage” is set to ON:

The first time you select the Player or Network Manager, you will see a Local Storage Error 
message:

A Silverlight warning will also appear prompting you to allocate an additional 100 MB of 
space for use by Silverlight:

You should make sure that there is enough available space on your startup disk, and then 
click Yes in the Silverlight dialog. 
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Working with Items in the Data Grid

Each manager page’s data grid lists all the available items of the specific type managed by 
that page. You can use the data grid to select one or more items and then perform context-
sensitive actions on them. 

Selecting Items in the Data Grid

Before you can perform an action on an item, you must have selected one or more items in 
the data grid. The selected items in a data grid are highlighted in blue.

To select an item:

Do one of the following:

• Click the item in the data grid.

• Use the up and down arrow keys to change the current selected item.

To select multiple items:

Do one of the following:

• Hold the Shift key down and click an unselected item to select all the items between 
the currently selected item and the clicked item.

• Hold the Ctrl key down and click an unselected item to add that item to the set of 
currently selected items.

To deselect an item:

Do one of the following:

• Hold the Shift key down and click a selected item to unselect all the items between the 
last clicked item and the clicked item.

• Hold the Ctrl key down and click a selected item to remove that item from the set of 
currently selected items.

Performing Context-Sensitive Actions on an Item

Once you have selected an item in the data grid, you can perform context-sensitive actions 
on it. The type of item determines the actions you can perform.

The following describes specific actions you can perform in each manager page.

To perform an action on an item, do one of the following:

• Choose an action from the ACTIONS menu.

• Right-click the item or selected items and choose an action from the Actions popup 
menu.
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Changing the Data Grid Layout

CoolSign provides a number of predefined views for each manager page. Each view defines 
which columns are displayed, how the grid is sorted, and any groupings that are applied to 
the grid.

For more information on managing views and adding new views, see “Managing Views” 
on page 32.

To change the data grid view:

Use the view combobox to select the view you wish to use.

Sorting Columns

You can sort the items visible in the data grid by one or more columns. You can add addi-
tional columns to the current sort by holding down the shift key while sorting.

TIP

The currently sorted columns are saved with the view’s state. 

To sort a column:

To toggle between ascending and descending sort order, click on the header of the column 
you want to sort by. 

Grouping Columns

NOTE
The CNM Player and Network managers no longer use this feature. You must use the 
Quick or Advanced Search functions for grouping (see “Searching for Items” on page 33 
for details).
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You can group the items visible in the data grid by one or more columns. 

TIP

The currently grouped columns and the group by box toggle state are saved with a view’s 
state.

To group by a column:

Do one of the following:

• Right-click on the column header and choose GROUP BY THIS COLUMN.

• Drag a column into the Group By Box.

To toggle the group box:

• Right-click on any column header and choose TOGGLE GROUP BY BOX.

To clear all groupings:

• Right-click on any column header and choose CLEAR GROUPINGS.

Resizing Columns

You can resize the visible columns to better fit the data displayed in the column. You can 
also lock the width of a column so that it doesn’t resize when you resize the entire CoolSign 
window.

TIP

Column widths are saved with a view’s state.

To resize a column:

Do one of the following:

• Click and drag on the column border to manually resize the column.

This content 
grid is grouped 
by the format 
column.
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2. Using CoolSign Network Manager 
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• Right-click on the column header and choose BEST FIT. The column will be resized to 
best fit the data visible in the column.

TIP

To tell the grid to resize all the visible columns to best fit the data, hold down the Ctrl key 
while choosing BEST FIT.

To lock a column width:

Right-click on the column header and choose LOCK COLUMN WIDTH. The column will no 
longer resize automatically when the window is resized.

Changing which Columns are Visible

You can add or remove columns from the data grid if you want to include different pieces 
of information in your view.

TIP

Visible columns are saved with a view’s state.
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2. Using CoolSign Network Manager 
Changing the Data Grid Layout
To add columns to a data grid:

1. Right-click on any column header and choose CHOOSE COLUMNS to show the Choose 
Columns toolbox.

2. Select one or more columns in the AVAILABLE COLUMNS list.

3. Click the right arrow button to move the columns into the SHOW THESE COLUMNS list.

4. Click Close.

To remove columns from a data grid:

• Right-click on the column header and choose REMOVE THIS COLUMN.

Lists all the avail-
able columns that 
haven’t been added 
to the data grid.

Click to show the 
internal hidden col-
umns. In most cases 
you will not find 
these columns useful.

Use the move buttons to move 
the selected columns between 
the available and shown lists.

Click this button to 
force all columns to 
resize to best fit the 
visible data.

Click this checkbox to 
shade every even row 
with a light gray color 
for easier viewing.

Use these buttons to 
move a selected column 
up or down in the list.

Lists all the columns that 
are visible in the data grid.
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Reordering Columns

You can change the order in which the visible columns are displayed to better organize your 
data.

TIP

Column ordering is saved with a view’s state.

To reorder a column:

Click on the column header and drag the column left or right to reposition it.

Managing Views

In addition to the predefined views that CNM provides for each manager page, you can add 
additional views to further customize how you work with items. The Manage Views dialog 
allows you to create new views, edit and delete existing views, import or export views, and 
reset views to their default state.

To add a new view:

1. Choose VIEWS > MANAGE VIEWS to display the Manage Views dialog.

2. Click New.

3. Enter a name for the view.

4. Choose columns for your view. For details, “Changing which Columns are Visible” 
on page 30.

To rename a view:

1. From the Manage Views dialog, click Rename.

2. Enter a new name for the view.

3. Click OK.

To delete a view:

• From the Manage Views dialog, click Delete.

Importing and Exporting Views

You can export views to a special CoolSign View File format (.cvw) so that you can 
transfer them between different CoolSign networks.
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To export a view to a CoolSign View file:

• From the Manage Views dialog, click Export and enter a name to save your view.

To import a CoolSign View file:

• From the Manage Views dialog, click Import and choose a view file using the open 
file dialog.

Resetting and Restoring Default Views

CoolSign provides predefined default views for each of the manager pages. If you modify 
or delete these views, you can reset or restore them back to their default settings using the 
Manage Views dialog.

To reset a view back to its default settings:

1. From the Manage Views dialog, select the view to reset.

2. Click Reset View.

NOTE
You can only reset predefined default views created by CoolSign. User-created views 
cannot be reset.

To restore deleted default views:

• From the Manage Views dialog, click Restore Default Views.

Searching for Items

The search box at the top of the manager grid can be used to perform instant and advanced 
searches (“About Manager Pages” on page 24). When you type in the Search box, you are 
automatically using the instant search function. The instant search is performed on the first 
column only (usually, the first column is "Name" but it is not always the case.) Especially 
when there are multiple levels of grouping in the grid. For example, in the audio manager 
grid, if it is grouped by Artist, then the first column becomes "Title". As a result, the Instant 
search searches on Title.

The advanced search can be done by clicking the “…” button.
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You can also filter which items are displayed in a data grid by using the Search dialog. 

To search for items:

1. To display the search dialog, do one of the following:

• Choose TOOLS > SEARCH.

• Right-click in the QuickBar and choose NEW SEARCH.

• Type Ctrl-F.

2. Define the search criteria using the Field, Condition and Value controls or click “...” 
in the search box at the top of the manager grid for advanced search capabilities.

3. To create a search expression that contains multiple criteria, check the “Show 

Advanced Search” box.

4. Click Find. The results of your search are displayed in the data grid and a temporary 
Search item is created in the QuickSets panel.

NOTE
Temporary search items are no longer available after you restart CNM. To make the 
results of your search available to subsequent sessions, you can save your temporary 
search as a QuickSearch. For details, “Using QuickSearches” on page 36.

Using the QuickBar

Each manager page (except for the Home page) has a quickbar that contains tools to help 
you organize and filter the items that appear in the data grid. While each manager page can 
have page-specific quickbar features, all the quickbar panels contain the QuickSet panel.
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About the QuickSet Panel

The QuickSet panel is available for every manager page (except for the Home page) and 
lets you create QuickSets, QuickSearches, and Folders to help you organize your data.

Using QuickSets

QuickSets are user-defined categories that you create and add items to. When you click on 
a QuickSet in the QuickBar panel, the data grid immediately displays only the items that 
you have added to that QuickSet. QuickSets are not exclusive, so you can add an item to 
more than one QuickSet.

IMPORTANT
Only CoolSign administrators using the Network Manager can create QuickSets. 
Content administrators, users who only have access to the web-based interface, can 
only use existing QuickSets; they cannot create QuickSets. 

To create a new QuickSet:

1. Right-click anywhere in the QuickSet panel and choose NEW QUICKSET.

2. In the QuickSet Properties dialog, enter a name for the new QuickSet.

3. Click OK.

To add an item to a QuickSet:

• Select one or more items in the data grid and drag them onto the QuickSet.

This is a QuickSearch.

This is a temporary 
search.

This is a Folder.

This is a QuickSet.
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To remove an item from a QuickSet:

• Right-click the item in the data grid and choose REMOVE FROM QUICKSET.

To clear all the items from a QuickSet:

• In the QuickSet panel, right-click the QuickSet and choose CLEAR QUICKSET.

To edit the properties of a QuickSet:

• Right-click the QuickSet and choose EDIT QUICKSET. You can change the QuickSet 
name or modify security settings.

To delete a QuickSet:

• Right-click the QuickSet and choose DELETE QUICKSET.

NOTE
Deleting a QuickSet does not delete the items in the QuickSet, just the QuickSet itself.

Using QuickSearches

QuickSearches are searches on your items that you can save persistently. When you click 
on a QuickSearch in the QuickSet panel, the data grid displays all the items that pass the 
filter expression of that QuickSearch. QuickSearches are “live”; if an item changes, the 
QuickSearch can automatically update to include the modified item.

Before you can create a QuickSearch, you must perform a search on the data grid. See 
“Searching for Items” on page 33. After you define a search, a temporary search item 
named Search (in italics) is created in the QuickSet panel. If you like this search, you can 
save it as a QuickSearch so that it is always available and so that other users can access it.

To convert a temporary search to a QuickSearch:

1. Right-click on the temporary search item and choose SAVE AS QUICKSEARCH.

2. Enter a name for your new QuickSearch.

3. Click OK.
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To edit the filter expression on a QuickSearch:

1. Right-click on the QuickSearch and choose EDIT QUICKSEARCH. 

The QuickSearch Properties dialog appears.

2. Click the Edit button to modify the search criteria.

3. In the Search dialog, define the search criteria, then click Find. For details, see 
“Searching for Items” on page 33.

4. Click OK.

To delete a QuickSearch:

• Right-click on the QuickSearch and choose DELETE QUICKSEARCH.

Organizing QuickSets and QuickSearches

Folders allow you to better organize your QuickSets and QuickSearches. You can create 
folders and then drag QuickSets and QuickSearches into the folder. Clicking on a folder 
will display all the items in every QuickSet in the folder.

NOTE
You can use folders to help organize your QuickSearches, but folders do not aggregate 
the results of the QuickSearches stored in the folder. 

To create a new folder:

1. Right-click anywhere in the QuickSet panel and choose NEW FOLDER.

2. Enter a name for the new folder.

3. Click OK.
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To add QuickSets or QuickSearches to a folder:

• Drag and drop the QuickSet or QuickSearch onto the folder. You can also nest folders 
within folders by dragging a folder onto another folder.

To remove a QuickSet or QuickSearch from a folder:

• Drag the QuickSet or QuickSearch out of the folder into the lower blank area of the 
QuickSet panel.

To rename a folder:

• Right-click the folder and choose RENAME FOLDER. 

To delete a folder:

• Right-click the folder and choose DELETE FOLDER. You will be asked whether to delete 
the folder and its contents or just the folder.

Printing and Exporting Data

You can print or export the items displayed in any data grid. You can export data to 
Microsoft Excel or to a delimited text file.

To print the items displayed in a data grid:

• Right-click in any column header and choose PRINT GRID.

To export items to a file:

1. Right-click in any column header and choose SAVE GRID DATA TO FILE.

2. Choose the file format that will be used to save the data.

• Excel (*.xls)—Saves the data in Microsoft Excel format. There are no additional 
options for this format.

• Text (*.txt)—Saves the data as a delimited text file. You can use the Text export 
properties to set the delimiter character, whether fields should be quoted, and 
whether to pad data with spaces.

3. Select a name and location to save the file onto your hard drive.
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What is CoolSign content? 

Content is perhaps the most important element within a CoolSign Digital Media Network. 
Without content, your screens would be dark. 

CoolSign includes a tool for authoring/converting basic content into digital assets, as well 
as robust tools for managing your digital assets to easily handle the challenges posed by 
large and diverse digital signage networks. 

NOTE
CoolSign Content Creator, a powerful authoring tool for creating digital assets, is available 
separately.

The CoolSign toolset provides extensive support for managing content:

• Supports the most popular standard digital file formats used by today’s content 
creation applications including MPEG-2, H.264, Windows Media 9, Flash, and 
Photoshop bitmaps.

• Converts Microsoft PowerPoint 2003 and 2007 presentations to JPG format, and 
PowerPoint 2010 presentations to WMV format. 

• Integrates seamlessly with Vistar Media, a third-party content provider or ad broker, 
to help you meet the growing demand for relevant content to populate your screens.

• Allows you to stream live content and display web pages. 

Creating CoolSign Content

Text, graphics, and multimedia assets to be used within CoolSign can be authored using any 
of the many available, professional content-authoring tools like Microsoft PowerPoint, 
Adobe After Effects, Adobe Photoshop, Adobe Flash, and Apple FinalCut Pro. Once you 
have created the digital assets for your content, you can convert those assets into CoolSign 
content by using the CoolSign Content Wizard optional CoolSign. You can then use CNM 
to import the CoolSign content into a CoolSign network. 

For more information, please refer to the following documents, available from the 
Haivision Download Center at https://www.haivision.com/download-center:

• Chapter 5, "Using the CoolSign Content Wizard."
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• CoolSign Content Creator User’s Guide

CoolSign Content Wizard 

The CoolSign Content Wizard is included with all CoolSign software and is designed to 
convert supported file formats into CoolSign content. The Content Wizard has a simple 
interface that allows you to import a file; set content properties like name, duration, and 
transition; select a thumbnail frame; and save CoolSign content, all in a few quick steps. 
For installation instructions, see the CoolSign Network Installation Manual.

CoolSign Content Wizard can also be used to convert media files to CoolSign content by 
pointing to one or more media assets. However, when CoolSign Content Wizard creates 
video capture content, it doesn’t have a media file. Instead, it requires specific information 
to convert a media file such as: Input, Standard, Channel, Resolution, etc. This information 
is output to a file called “Control.xml”, which prompts CoolSign players to play the 
specified video capture content. For detailed instructions, see “Creating video capture 
content” on page 77.

CoolSign

CoolSignCoolSignCoolSign

WARNING

Acquiring Content

In addition to authoring your own content, you can acquire content from other sources, such 
as streaming live content, displaying web pages, or subscribing to place-based advertizing. 

Streaming Live Content 

With CoolSign 5.0, you can stream live video content to your CoolSign displays.Video 
streams (including those with FEC or encryption) from the Havision Furnace solution are 
supported, as are HD and SD streams from the Havision Makito encoders. Unencrypted 
video streams from other sources are also supported. For more information, see “Streaming 
Content” on page 112.
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Displaying Web Pages 

Another much requested feature that has been added to CoolSign 5.0 is the ability to include 
internet web pages as content on CoolSign displays. You can schedule and present news, 
weather, sports and other rich web content from any valid URL on your CoolSign network.

Integrating Vistar Media 

Vistar Media (www.vistarmedia.com) operates a marketplace for digital place-based 
advertising. Vistar Media’s platform automates the delivery of ads from buyers to digital 
signage networks. This enables advertisers to connect seamlessly to ad networks to sell 
their ads — Vistar Media effectively acts as a broker between ad sellers and ad buyers. 

The CoolSign Vistar Content feature gives CoolSign administrators the ability to schedule 
ad content purchased through Vistar Media — an increasingly popular solution for filling 
spare capacity in a pipeline.

A CoolSign administrator can schedule a piece of Vistar content, such that individual 
players in the CoolSign network grab ads for specified time slots, play them back, and then 
report the playback to Vistar Media.

Supported File Formats

Assets for CoolSign content can be authored using numerous industry-standard production 
tools available from companies like Adobe, Avid, and others. The remainder of this chapter 
discusses requirements for developing assets for CoolSign.

The following digital formats are supported by CoolSign:

Using Digital Video In CoolSign

Digital video is the most popular format for authoring CoolSign content. Digital video can 
be created in any number of production tools including Adobe After Effects, Avid Media-
Composer, Apple FinalCut Pro, and Adobe Premiere. The preferred formats for encoding 

Audio Image Video

MP3 bmp

gif

jpeg

png

psd

WMV

Flash

MPEG-1

MPEG-4

AVI

M2V

MOV

MP4 (H.264 only)

H.264

XVid

DivX
CoolSign Network Manager User’s Guide, Version 5.0, Issue 01 71



4. About Content 
Supported File Formats
and playback of digital video in CoolSign are H.264 or Windows Media 9. Both formats 
are capable of high-quality video playback at both SD and HD resolutions. H.264

H.264 is designed for broadcast-quality digitally-encoded audio and video. It offers good 
image quality and is the standard for DVD video. Most authoring applications do not 
encode directly to H.264 and require a 3rd-party encoding tool or plug-in. 

NOTE
H.264 defines different standards for resolution and bit rate called profiles and levels. In 
order to encode MPEG-2 at greater resolution than NTSC (720x480), you will need an 
encoder that supports High Profile and High-1440 Level. Most hardware H.264 encoders 
do not support the higher profiles and levels.

The following are some applications that can be used to encode H.264:

• Adobe After Effects 6.5 (www.adobe.com)1

• Adobe Premiere Pro (www.adobe.com)

• MainConcept MPEG Encoder (www.mainconcept.com)1

• TMPGEnc Plus 2.5 (www.pegasys-inc.com)

• Discreet Cleaner XL (www.discreet.com)

NOTE
The Discreet Cleaner XL only supports encoding at 720 x 480.

CoolSign supports H.264 program streams (multiplexed video/audio) or video elementary 
stream (video only) at data rates up to 15 Mb/s.

MPEG-1

While CoolSign fully supports MPEG-1 digital video, we recommend that H.264 be used 
for its superior resolution and quality. In most cases, MPEG-1 can be encoded in the same 
way as H.264.

Windows Media 9

Microsoft Windows Media technology is an alternative to H.264 for full-screen, digital 
video playback. Windows Media has certain advantages: more authoring tools natively 
support encoding to WMV and, in many cases, the file size of Windows Media is signifi-
cantly smaller than H.264.

1. Please refer to “Using Flash-based Content” on page 356 for detailed steps on encoding MPEG-2 using 
Adobe After Effects and MainConcept MPEG Encoder.
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The following are some applications that can be used to encode Windows Media 9:

• Adobe After Effects / Adobe Premiere Pro (www.adobe.com)

• Discreet Cleaner XL (www.discreet.com)

• Microsoft Windows Media Encoder 9 (www.microsoft.com)

Windows AVI

Although AVI is a supported technology, it’s enclosed encoding must have a corresponding 
decoder on the player for proper playback.

CoolSign Encrypted Video Format

In cases where security of digital video assets is important, the CoolSign EVF format is 
available to encrypt MPEG-2 video so that only CoolSign can playback the assets. For more 
information, please contact your sales representative.

Using Flash in CoolSign

CoolSign supports Shockwave Flash (SWF) vector animation format created in applica-
tions like Adobe Flash, Adobe LiveMotion and Adobe After Effects. 

SWF files exported as Versions 4–9 are supported.

WARNING

You can only control the volume of SWF files that are version 8 or older. With SWF version 
9 files, it is not possible to control the player volume from CoolSign.

NOTE
SWF files for use with CoolSign should be authored at a playback speed of 30 frames per 
second. Lower frame rates can be used, but playback will appear choppier than movies 
created at full 30 fps. 

Take care to avoid animating complicated vector shapes, large bitmaps, and numerous 
objects simultaneously as this can result in poor playback performance. In these cases, it is 
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recommended that you export into AVI or QuickTime format and then encode to H.264 or 
WMV formats using a standalone encoding application.

NOTE
Refer to “Using Flash-based Content” on page 356 or the CoolSign Tech Note “Creating 
Flash-Based Content for CoolSign” available from the CoolSign Software Download Site 
at: http://support.haivision.com

Using bitmaps in CoolSign

If you don’t require animation in your content, CoolSign supports displaying static bitmap 
assets. Bitmap assets can be authored in any software that supports the following formats:

• Photoshop (*.psd)—Photoshop version 3.0 or higher supported. Layered files will 
be flattened. Only RGB mode is supported. Only the first alpha channel will be used.

• Windows Bitmap (*.bmp)—Windows Bitmap can be saved as either 24-bit or 32-
bit.

• JPEG (*.jpg)—JPEGs should be saved with maximum quality settings to minimize 
compression artifacts.

• Portable Network Graphics (*.png)

• Graphics Interchange Format (*.gif)—GIF animation is not supported.

Assets should be saved at 16-bit, 24-bit, or 32-bit color depth. 1-bit and 8-bit images are not 
supported.

NOTE
CoolSign fully supports 32-bit images. If you are displaying 32-bit bitmap with an alpha 
channel, the transparent regions will be transparent to the black background. If you are 
using overlapping regions, you can use alpha channel transparency to show through from 
one region to the one below. Be sure to delete unwanted alpha channels before importing 
bitmap content as there is no mechanism for “turning off” an alpha channel once 
converted into content.

Using PowerPoint in CoolSign

PowerPoint slides and shows can now be imported through the CoolSign Content Wizard:

• With PowerPoint versions 2003 and 2007, the .jpg format is converted to run slide-to-
slide. 

• With PowerPoint versions 2010, the .wmv format is converted to run slide-to-slide. 
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You can also adjust the duration between slides as well as adjust transitions that are 
between one content item and other content items that are on the same channel.

NOTE
Microsoft PowerPoint has to be installed on the same box as the Content Wizard. 

To adjust the slide duration and adjust the transition between content:

1. Go to the Content Wizard and select Create.

2. Select CHOOSE ASSET (“Convert single asset” is the default).
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3. Click Browse to select a PowerPoint presentation to convert to CoolSign content.

4. Select SET OPTIONS and then select the slide duration as well as the slide transition 
between content.

5. Click Apply Changes so the new settings take effect. Note that PowerPoint version 
2007 is being used.

With PowerPoint 2010, you can import a PowerPoint file and Content Wizard will convert 
it into a .wmv file. Note that PowerPoint versions 2003-2007 do not support .wmv movie 
presentations.

1. If using PowerPoint 2010, these features are available to manipulate your converted 
.wmv content:

• Volume Gain

• Asset Properties

• Content Resize Settings

• Content Activation/Expiration 
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Creating video capture content

To create video capture content:

1. On the CHOOSE ASSET tab, click “Configure video capture”.
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2. Select your desired video capture specifics from the drop-down menus and then click 
Next. Video Capture options include:

• Input—Composite, RGB, S-Video, and Tuner

• Standard—NTFC and PAL

• Channel—Channel number

• Resolution—Resolution standard

• Tuner Settings—Mode, Type, and Country/Region

NOTE

If you select Tuner as your input, you’ll need to specify the type of antenna or cable 
along with the country/region.

3. On the SET OPTIONS tab, select the desired video capture settings, and then click Next.
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4. Click SELECT THUMBNAIL, select an external image as the content thumbnail, and then 
click Next.

NOTE

If no image is specified, CoolSign Content Wizard uses the default black thumbnail.
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5. Click the CREATE tab. From this screen you can:

• Select a folder to save your content in

• Import created content into a CoolSign network

6. Click Finish to save your video capture content.
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Using Web Pages as Content

This section provides instructions for displaying internet web pages on a CoolSign Player. 
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To display web page content: 

1. Open the Network Content Manager and click the Content icon in the navigation 
sidebar.

2. From the Actions menu, select the option CREATE WEB CONTENT...
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3. For the Site URL field, enter the internet address (URL) for the site that you want to 
display and click the Apply button.

4. Switch to the General tab and define the content Name and Duration fields.
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5. Click the OK button. At this point, the content can be scheduled into a channel like 
any other CoolSign content. See “Adding Items to a Channel” on page 145.

NOTE
To display web content, you will need to install the Mozilla Firefox browser and 
corresponding Flash plug-in on the Player Node if you want to display web pages that 
contain Flash (for example, YouTube).

Using Streaming Content

There are two ways to acquire streaming content:

• Direct (via Furnace v6.3)

• URL (via Makito)

Streaming Direct 

This section provides instructions for playing a live stream on a CoolSign display. 

NOTE
You can configure the player into multiple reqions if you want to show the live feed in only 
a section of the screen. See “Configuring Multi-Region Players” on page 191.

Furnace Setup

For information on how to set up an output stream, please refer to the Furnace product 
documentation available from the Haivision Download Center (www.haivision.com/down-
load-center).

• Follow the instructions in the Furnace Quick Start Guide to power on the unit and log 
in to the Web Interface.

• Refer to the Furnace User’s Guide or the online help (available from the Web 
Interface) for instructions on how to configure a Furnace Encoder to provide an FEC 
stream to a CoolSign Player.

IMPORTANT
The Furnace device should be on the same subnet as the player.
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Content Acquisition

Once the Furnace Encoder is configured, its output video stream can be displayed on a 
CoolSign Player Node across the LAN or Internet, as determined by the Network Admin-
istrator.

To stream content from a Furnace source: 

1. Open the Network Content Manager and click the Content icon in the navigation 
sidebar.

2. From the Actions menu, select the option CREATE STREAMING CONTENT...
CoolSign Network Manager User’s Guide, Version 5.0, Issue 01 85



4. About Content 
Using Streaming Content
3. For the Source Type field, verify that the Haivision FURNACE [Default] drop-down 
menu item is selected.
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4. Provide the appropriate Furnace information in the remaining fields on the page and 
then click the Apply button.

NOTE
This field is comprised of the UDP address and port.
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5. Switch to the General tab and define the content Name and Duration fields.

6. Click the OK button. At this point, the content can be scheduled into a channel like 
any other CoolSign content. See “Adding Items to a Channel” on page 145.

Streaming via a URL

This section provides instructions for configuring the Haivision Makito H.264 encoder to 
stream to a CoolSign Player. 

Makito Setup

For information on how to set up an output stream, please refer to the Makito product docu-
mentation available from the Haivision Download Center (www.haivision.com/download-
center).

• Follow the instructions in the Makito Quick Start Guide to power on the unit and log 
in to the Web Interface.
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• Refer to the Makito User’s Guide or the online help (available from the Web Interface) 
for instructions on how to configure a Makito Encoder to provide a stream to a 
CoolSign Player.

Content Acquisition

Once the Makito Encoder is configured, its output video stream can be displayed on a 
CoolSign Player Node across the LAN or Internet, as determined by the Network Admin-
istrator.

To stream content from a Makito source: 

1. Open the Network Content Manager and click the Content icon in the navigation 
sidebar.

2. From the Actions menu, select the option CREATE STREAMING CONTENT...
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3. For the Source Type field, use the drop-down menu to select URL.
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4. In the next field, provide the Source URL information and click Apply.

NOTE
This field is comprised of the UDP address and port.
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5. Switch to the General tab and define the content Name and Duration fields.

6. Click the OK button. At this point, the content can be scheduled into a channel like 
any other CoolSign content. See “Adding Items to a Channel” on page 145.

Working with Templates

Templates are a great way to kick start your content collection. A template allows you to 
produce multiple pieces of content with the same layout quickly. You use the web-based 
interface (WUI) to create an instance, or copy, of the template for editing. Then you modify 
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5. Using the CoolSign Content Wizard

The CoolSign Content Wizard guides you through a series of steps to convert your digital 
media assets into content that can be played back on a CoolSign Digital Media Network. 
At any point, you can click the Prev button to return to previous steps.

Starting the CoolSign Content Wizard

To start the CoolSign Content Wizard: 

1. Browse to the CoolSign directory and open the Content Wizard folder.

2. Double-click the ContentWizard.exe to open the tool.

Converting Content

Step 1: Choose Asset(s) to Convert

Determine the media assets that you want to create into CoolSign content. You can convert 
a single asset into CoolSign content,configure video capture, or batch convert multiple 
assets.
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To convert a single asset into CoolSign content:

1. Select the CONVERT SINGLE ASSET radio button.

2. Click Browse to locate the asset file you wish to convert. 

If you are converting a Flash asset that needs to load external files (such as images) at 
run time, make sure that the external files are in the same folder as your Flash asset, or 
in one of its subfolders. For example:

ContentFolder\ (root folder)
ContentFolder\myFlash.swf (the asset that you’re converting)
ContentFolder\Image\background.jpg
ContentFolder\Image\banner.jpg

3. Click Finish to complete the content creation process. 

The Content Wizard prompts you as to whether or not you want to include all files in 
the ContentFolder folder and its subfolders (in this example, background.jpg and 
banner.jpg). After you confirm your choice, the two image files are packaged with 
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the Flash asset, resulting in a single piece of CoolSign content.

NOTE

Do not include any unrelated files in the folder that contains your Flash assets. If the 
content folder (or any of its subfolders) contains any unrelated files, they are included 
into your content and eventually imported to the network as well.

NOTE

For this reason, avoid importing Flash content from the desktop. Attempting to do so 
causes the entire contents of your desktop to be imported as well.

To configure video capture:

1. Select the CONFIGURE VIDEO CAPTURE radio button.

2. Click Browse to locate the asset file you wish to convert. 

To batch convert multiple assets into CoolSign content:

1. Select the Batch convert multiple assets radio button.

NOTE

If you select this button, you cannot include external files for a Flash asset, as 
described above.

2. Do one of the following:

• Click Add All Assets in Folder to recursively add all the assets located in a spe-
cific folder and subfolders to the batch list.

• Click Add Asset to add a single asset to the batch list.

• Click Remove Asset to remove a selected asset from the batch list.

3. When you’ve added all the assets you want to batch convert, click Next to proceed to 
the Set Options step.
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Step 2: Set Options

In this step, you can set properties regarding your content and preview how your content 
looks on different types of displays.

Setting Content Properties

You can set the following properties for your content:

Name—Set the name of this content as you wish it to appear in the CoolSign Network 
Manager. The default name is the name of the imported asset.

NOTE
With multi-file Flash assets, be sure to specify a legal folder name, so that multi-file Flash 
content will work properly.

Format—The format is automatically set based on the aspect ratio of the imported asset. 
You can change the format if the auto-detected value is incorrect. Once imported into 
CoolSign Manager, you can only schedule this content into channels with the same format.

Use Legacy Flash Player (enabled only for assets that are Flash 4 or earlier)—When 
checked, provides backward compatibility for SWF files that are Flash 4 or earlier.

Duration—You can adjust the length of time for which the content plays. If the content 
includes video or Flash assets, setting the duration to less than that of the video cuts off the 
video playing. Setting the duration to longer than that of the video asset causes the video to 
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hold on the last frame for the remainder of the content play. If the Set Duration to Asset 
Duration box is checked, the Duration field is greyed out.

Set Duration to Asset Duration—This checkbox is enabled only when digital video or 
Flash assets are being converted. Checking this box automatically sets the duration of the 
content to match the duration of the imported asset.

If the duration is set to within 0.1 of a second, it is rounded off to a the nearest second. For 
example, if the duration is any value between 9.90 and 10.1, it is rounded to 10 seconds. 
This is done to avoid unexpectedly strange values in the duration field.

Volume Gain—You can use volume gain to modify the overall volume level of all video, 
flash, or sound assets used in the content. The value can be between -100 and 100, with 0 
being the normal, unmodified volume level of the assets. You can use volume gain to 
normalize the volume of your content in relation to each other so that no one content item 
is softer or louder than the others.

Transition—You can set a transition effect and duration that is used to transition into the 
CoolSign content when played back.

Setting Asset Properties

Resolution—The horizontal and vertical resolution of your content in pixels.

Pre-rotation—Rotation of the asset in degrees.

Show Transparency (enabled only for Flash assets)—When checked, whatever areas of 
the Flash file were designated to be transparent are rendered with a transparent background. 
Checking this box has no visible effect if the Flash file contains no transparency.

Timeless (enabled only for Flash assets)—When set, CoolSign Player ignores the Flash 
asset's timeline.

Setting Content Resize Settings

Use these settings to define how the content should be displayed on players that are of 
different resolution than the selected content. The preview window automatically updates 
to reflect the content resize settings so you can dynamically preview the options. The 
following options are available:

• Scale Content To Fit—Scales content to fit the resolution of the player the content is 
scheduled on. If the aspect ratio of the player does not match the content’s aspect ratio, 
the content is stretched non-linearly to fill the player unless Preserve Aspect Ratio is 
checked.

• Preserve Aspect Ratio—Forces scaled content to preserve its original aspect ratio 
when played on players with different resolutions and aspect ratios than the content’s. 
The behavior of this checkbox is further defined by the following radio buttons:

• Crop edges of content—When scaling to fit, the content is scaled linearly until the 
smaller of the content’s width or height matches the smaller of the player’s width 
or height. This can result in pixels being cropped off the edge of the player.
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• Letterbox content—When scaling to fit, the content is scaled linearly until the larg-
er of the content’s width or height fits into the player’s width or height. The empty 
area that remains is black.

Setting Content Activation and Expiration

Content can be set to activate and/or expire at a certain date and time.

• Content Activation—Restrict when content is available to start playing. Content can 
be scheduled at any time but if its activation date is set to something other than Now, 
it does not play until the current date and time is past the set date.

• Content Expiration—Automatically delete content after the specified date and time. 
Content that has expired is deleted from a CoolSign network, including any players it 
was scheduled on, and moved to the Content Recycle Bin. All schedule and play 
history is lost when the content expires.

Previewing Content

The Preview content window displays a preview of your content and how it looks on 
different display types. 

You can select different pre-defined display types or define your own custom resolutions. 
You can adjust the content’s resize properties to make sure you have the correct settings to 

Access the Preview Content 
window from the Options 
drop-down menu.
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ensure that your content looks correct across different display types. If you didn’t install 
Direct X, you cannot review content.

NOTE
The Display type and Resolution settings are used for previewing only. They do not affect 
your content settings in any way.

To select a display to preview your content on:

1. Click the OPTIONS menu to open the Preview Options popup menu.

2. Do one of the following:

• Select a pre-defined display type from the Display type pull-down menu. The ap-
propriate resolution is automatically set and the preview window is updated to re-
flect your choice.

• Enter custom x and y resolutions into the Resolution fields. The preview window 
is updated to reflect your values.

3. Use the transport buttons to control playback and looping of the content preview.
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Step 3: Select Thumbnail

In this step, you can select a thumbnail image for your asset.

NOTE
If you are batch-converting multiple assets, a thumbnail for each content is automatically 
selected from a frame a few seconds from the end of the asset.

To select a thumbnail image for your content:

1. Using the content preview transport buttons or the time slider, set the preview to the 
frame of the asset you would like to use as a thumbnail.

2. Click Set thumbnail to current frame and the selected thumbnail image appears in 
the Thumbnail area. 

-or-
Click Browse to locate an image file that you wish to use as a thumbnail for this asset. 
The image must be in one of the following formats: JPEG (*.jpg), Windows Bitmap 
(*.bmp), or Portable Network Graphics (*.png).

3. Use the Options button to preview how the thumbnail will render on a variety of 
monitor types at various resolutions.

When you’re done, click Next.
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Step 4: Create

In this step, you set the destination folder where your converted CoolSign content should 
be saved, along with some other settings.

Copying or Moving Asset Files

By default, when your content is created, the Content Wizard creates a copy of your 
imported asset and leaves the original file intact. If you are batch-processing a large number 
of assets and the destination folder is on the same hard drive as the original files, you can 
select Move asset file to output folder to force the Wizard to move the original file instead 
of copying it. This makes the batch process much faster.

NOTE
You should always keep a separate backup of your original assets.

Selecting a Folder to Save Your Content In

Before you can finish converting your asset into CoolSign content, you must select a desti-
nation folder in which to save the converted content.

To do so, click Browse to select a desired folder.
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Importing Content into a CoolSign Network

If you want the Content Wizard to import your content directly into the CoolSign network, 
check the Import created content into a CoolSign network box. Using the radio buttons, 
indicate the action to take if there is already content with the same name as the content you 
are importing.

NOTE
To import content directly from the Content Wizard, you must have Write Content 
capability. For details, see 21. "About Security" on page 322 in the CoolSign Network 
Mangager User’s Guide.

When the CoolSign Manager login dialog appears, enter your user name and password and 
select the CoolSign network where you wish to import the content.

After verifying your login credentials, the Content Wizard imports the content into the 
CoolSign network, then disconnects you from the CoolSign network.

Completing the Content Wizard

After completing each step in the wizard, click Finish to convert the selected asset(s) into 
CoolSign content. The wizard creates your content in the destination folder ready for 
import into a CoolSign network. For more information, see “Managing Content” on 
page 106 of the CoolSign Network Mangager User’s Guide.
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CNM provides a rich set of features to help you organize and manage the content in your 
CoolSign network. You can use CNM to stream, import, or update content; modify content 
properties like duration, transitions, scaling and volume; review play history and sched-
uling statistics; and even preview the content as it will appear on your CoolSign players.

Working with Content

Importing Content

Content in CoolSign must be imported into the system before it can be scheduled or played 
on the CoolSign players connected to your network.

To import content into your CoolSign network:

• From the Content Manager, choose ACTIONS > IMPORT CONTENT and select the content 
folder you wish to import. Note that you can also batch import content by selecting a 
folder that contains multiple content folders.

The Content Import dialog shows the progress of any current and pending content imports.
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If content already exists with the same name as the content you are importing, an alert 
dialog will ask you if you want to replace or rename the imported content. Similarly, if the 
content that is importing contains a data table that is named the same as an existing data 
table, then a warning appears. You can then choose "Replace" or "Keep". 

If you select “Replace”, the old data table is deleted and a new data table is created, which 
means:

1. All the data is lost.

2. Any content currently binding to that data table will no longer have a binding table 
attached to it. Instead, you’ll have to rebind it manually.
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TIP

You can continue working with CNM while the import occurs in the background or you can 
queue up additional imports by repeating these steps.

TIP

You can also import content folders by dragging and dropping them from the Windows 
desktop directly into the Content Manager data grid or onto the Content Manager icon. 
You can drag multiple folders at once or drag new folders one at a time.

Using Template-Based Content

Templates are a new feature in CoolSign 5.0. Templates can only be created using the 
Content Creator tool (see the Content Creator User’s Guide for more information). Several 
default templates are provided by default. 
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4. When prompted to verify, click Yes.

Using Web-Page Content

You can display internet web pages on a CoolSign player.

To display web page content: 

1. Open the Network Content Manager and click the Content icon in the navigation 
sidebar to open the Content screen.

2. From the Actions menu, select the option CREATE WEB CONTENT...

3. For the Site URL field, enter the internet address (URL) for the site that you want to 
display and click the Apply button.
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4. Switch to the General tab and define the content Name and Duration fields.

5. Click the OK button. The web site content will appear in the Content pane.
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6. At this point, the content can be scheduled into a channel like any other CoolSign 
content. See “Adding Items to a Channel” on page 145.

Streaming Content

There are two ways to acquire streaming content:

• Direct (via Furnace v6.3)

• URL (via Makito)

Streaming Direct in CoolSign from a Furnace Device

Before you can stream content from your Furnace device, you must configure it. Refer to 
C. "Configuring Devices to Stream Content", on page 375. Make sure to make note of the 
following information regarding your Furnace device:

• Furnace Server URL (comprised of the UDP address and port)

• User name (with admin privileges) 

• Password

• Furnace Consumer Key

• Furnace Consumer Secret

Once the Furnace Encoder is configured, its output video stream can be displayed on a 
CoolSign player node across the LAN or Internet, as determined by the Network Adminis-
trator.

To stream content from a Furnace source: 

1. Open the CoolSign Network Manager (CNM) and click the Content icon in the 
navigation sidebar to open the Content screen.

2. From the Actions menu, select the option CREATE STREAMING CONTENT...
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3. For the Source Type field, verify that the Haivision FURNACE [Default] drop-down 
menu item is selected.

4. Provide the appropriate Furnace information in the remaining fields on the page (see 
C. "Configuring Devices to Stream Content", on page 375) and then click the Apply 
button. 
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5. Switch to the General tab and define the content Name and Duration fields.

6. Click the OK button. 

At this point, the content can be scheduled in a channel like any other CoolSign content. 

Streaming a URL in CoolSign from a Makito Device

Before you can stream content from your Makito device, you must configure it. Refer to C. 
"Configuring Devices to Stream Content", on page 375. Make sure to make note of the 
following information regarding your Furnace device:

• Makito Source URL (comprised of the UDP address and port)

To stream content from a URL source:

1. Open the CoolSign Network Manager (CNM) and click the Content icon in the 
navigation sidebar to open the Content screen.
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2. From the Actions menu, select the option CREATE STREAMING CONTENT...

3. In the Content Properties dialog window, click the Source Type drop-down menu and 
select the URL menu item.

4. Enter the Source URL data to which the Makito is streaming and click the Apply 
button.
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5. Switch to the General tab and define the content Name and Duration fields.

6. Click the OK button. 

At this point, the content can be scheduled in a channel like any other CoolSign content. 

Updating Content

Once imported, the assets within your content are locked down and can no longer be 
modified from within the system. If you modify either the content script or the assets within 
your content, you must re-import to update the existing content. If the content you are 
updating has been scheduled, CoolSign will automatically update the content on those 
players where it has been scheduled, including transferring any required files.

Exporting Content

You can export content that has been imported into CNM if you need to modify the content 
externally or transfer it to another network. 
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To export content from your CoolSign network:

1. In the Content Manager data grid, select one or more content items that you wish to 
export.

2. Choose ACTIONS > EXPORT CONTENT.

3. Select a destination folder from the Browse for Folder dialog.

4. Click OK. A content export progress dialog will appear.

NOTE
You should always back up your content externally from CoolSign in case you experience 
any issues that result in loss of data or corruption.

Duplicating Content

You can duplicate content that has been imported into CNM.

To duplicate content from your CoolSign network:

1. In the Content Manager data grid, select one or more content items that you want to 
duplicate.

2. Choose ACTIONS > DUPLICATE CONTENT or right-click and choose DUPLICATE 
CONTENT.

3. Enter a name for the duplicated content. If you are duplicating multiple content items, 
a default name, Copy of [content name], is used.

Deleting Content

If you no longer plan to use a content item, you may choose to delete it from the network. 
Deleted content is immediately removed from any channels or playlists and ceases 
playback on all players where it is scheduled. 

WARNING

Previous versions of CNM provided a recycle bin from which you could recover 
deleted content. This functionality is no longer available in CNM. Deleted content 
cannot be recovered. Be sure that you have a backup of your content outside of the 
system. If you want to export your content from the system before deleting, refer to 
the above section on Exporting Content.
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To delete content:

1. In the Content Manager data grid, select the content you want to delete. You can 
select multiple items.

2. Do one of the following:

• Choose EDIT > DELETE.

• Right-click and choose DELETE.

• Press the Delete key on your keyboard.

Using the Content Properties Dialog

The Content Properties dialog allows you to modify certain properties of selected content 
and to view useful information about how your content is scheduled and how many times 
it has played.

To display the Content Properties dialog:

Do one of the following:

• Select the content item in the Content screen and choose ACTIONS > EDIT CONTENT 
Properties.

• Double-click the content item.

• Right-click on the content item and choose EDIT CONTENT PROPERTIES.

Editing Content Properties

After importing, you may find it necessary to modify one or more properties of your 
content. Rather than having to change the content externally and reimport, you can adjust 
many of the content’s properties directly from the Content Properties dialog. 

NOTE
You can only modify properties of the content item itself. You cannot edit or change the 
individual assets used within the content. If you want to modify an asset (for example, 
change a bitmap or edit an MPEG-2 video), you must re-import the entire content item to 
replace the existing item in CoolSign.
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To edit the properties of a content item:

1. From the Content Properties dialog, change one or more of the content properties.

2. Click OK or Apply Changes. Changes are immediately applied to the selected content 
and on any players where the content is scheduled.

NOTE
Content is only updated on players that are currently online. If a player is offline, it will 
automatically receive any updates to modified content as soon as it comes back online.
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In the Content Properties dialog, the General tab allows you to view and/or modify the 
following properties of the selected content:

Name—The content’s name is used wherever the content is referred to, including 
playlogs and scheduled items.

Version—Each time the content is modified or updated, the version number is incre-
mented. 

Format—Displays the player format that this content was authored for. Content can 
only be scheduled in regions that match their format. This value cannot be modified.

Resolution—Displays the pixel height and width at which the content was authored. 

Size—Displays the total size of the content including all its assets.

Duration—Use this property to adjust the length of time for which the content plays. 
If the content includes video or flash assets, setting the duration to less than the video’s 
duration will cut off the video playing. Setting the duration to longer than a video as-
set’s duration will cause the video to hold on the last frame for the remainder of the 
content play.

When the content contains a data panel and is set to Auto-fit duration, the duration can-
not be adjusted and will display "Dynamic duration". The duration is determined by 
the number of rows of its binding data table.

Volume Gain—Use volume gain to modify the overall volume level of all video, 
flash, or sound assets used in the content. The value can be between -100 and 100 with 
0 being the normal, unmodified volume level of the assets. 

NOTE
You can adjust the overall volume of player from the Player Properties dialog. You only 
need to adjust the volume gain if you want to “normalize” the volume of a content item 
relative to the other content.

WARNING

You can only control the volume of SWF files that are version 8 or older. With SWF version 
9 files, it is not possible to control the player volume from CoolSign. 

Transition—Allows you to set the effect that is used to transition from the previously 
playing content into the selected content. In general, transitions first change to the tran-
sition color and then into the next content item. (If the transition type is FadeToBG, 
Cut, or CrossFade, the color property is ignored.)

Transition Length—Use to set the number of seconds in which the transition will oc-
cur (defaults to one second).
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Setting Content Resize Settings

In the Content Properties dialog, you use the Content Resize settings to define how the 
content should be displayed on players. The options are as follows:

Scale content to fit—Scales content to fit the resolution of the player the content is 
scheduled on. If the aspect ratio of the player does not match the content’s aspect ratio, 
the content is stretched non-linearly to fill the player unless Preserve Aspect Ratio is 
checked.

Preserve aspect ratio—Forces scaled content to preserve its original aspect ratio 
when played on players with different resolutions and aspect ratios than that of the con-
tent. The behavior of this checkbox is further defined by the following radio buttons:

Crop edges of content—When scaling to fit, the content is scaled linearly 
until the smaller of the content’s width or height matches the smaller of the 
player’s width or height. This may result in pixels being cropped off the edge 
of the player.

Letterbox content—When scaling to fit, the content is scaled linearly until 
the larger of the content’s width or height fits into the player’s width or height. 
The empty area that remains will be black. 
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The following images show how a 320x240 MPEG-1 on a 848x480 display screen would 
appear with the different available content resize settings:

TIP

As a general rule, you should turn on Scale content to fit display and turn off 
Preserve aspect ratio. This ensures that the content always fills the screen regardless 
of the resolution and aspect ratio of the display device you are using.
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Setting Content Activation and Expiration

You can use the content activation and expiration properties to globally control when 
content is enabled to play across all of your channels and players. 

Content Activation

You can use content activation to set a date and time when the content should be enabled 
to start playing.

TIP

You can use content activation if you want to schedule some content immediately so it is 
transferred to your players but you don’t want it to start playing until a specific date and 
time. Content activation allows you to control the activation date globally across all 
channels and playlists, instead of within each individual schedule.

To set the activation date of content:

1. Click the Activates At radio button.

2. Click the Activation Date Editor to edit the activation date at which the content can 
start playing.

To set content to be active now:

• Click the Activates Now radio button.

Content Expiration

You can use content expiration to set a global date and time for your content to stop playing 
everywhere regardless of its scheduling properties. When content expires it is automatically 
removed from all channels and playlists across your network. 

To set the expiration date of content:

1. Click the Expires At radio button.

2. Click the Expiration Date Editor to edit the expiration date at which the content 
should stop playing.
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To set content to never expire:

• Click the Expires Never radio button.

WARNING

In CoolSign 4, expired content is not automatically deleted but is displayed in the Content 
Manager in red to indicate that it is expired. If you want to remove the expired content, you 
must manually delete it.

Previewing Content

You can preview your content as it will play back in a CoolSign player directly from the 
Content Properties dialog. 

To preview content:

In the Content Properties dialog, click the Preview Content button.

NOTE
When you first preview a content item, the asset files required for that content are 
transferred from the CoolSign Network Controller and cached in a temporary folder in your 
CNM installation directory. When you preview a portion of dynamic content binding to a 
data table, that contains more than 20 rows, you can only preview the first 20 rows.

WARNING

Content preview is only supported on PCs that meet the minimum requirements for a 
CoolSign player. Older PCs or unsupported video cards may not be capable of content 
previewing.

Setting the Thumbnail Image for Content

You can set the thumbnail image displayed in the Content Manager grid and in the Content 
Properties dialog when you are previewing the content.

To set the thumbnail for content:

1. In the Content Properties dialog, click the Preview Content button.

2. Use the preview content transport controls to pause the preview on the frame you 
want to use for your thumbnail. You can use the frame advance and rewind buttons to 
fine-tune the frame to use.

3. Click the Set Thumbnail to Current Frame button.
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Adding Comments to Content

You can add comments to any content item if you want to track additional information 
about the content. When you add a comment, the user who entered the comment and a 
timestamp is automatically added.

To add a comment:

Click the Add button beneath the comments grid and enter your comment into the field 
provided.

To remove a comment:

Select the comment in the comments grid and click the Remove button.

Viewing Information About Content

You can use the Content Properties dialog to view information about your content. For 
example, you can review where your content is scheduled, any issues that the content may 
be having, and retrieve play history reports for the content.

Viewing the Assets Used Within Content

You can view the names of the asset files that are part of a content item from the Assets 
tab of the Content Properties dialog.

To view the assets used within a content item:

From the Content Properties dialog, select the ASSETS tab.

To edit the control script for a content item:

1. In the Assets tab of the Content Properties dialog, click the Edit Control Script 
button.

2. In the Edit Control Script dialog, make any desired changes to the control script 
XML.

3. Click OK to close the dialog.

4. Click OK or Apply Changes to save your changes.

NOTE
You should only attempt to edit the control script of content if you are familiar with hand-
editing content scripts. Invalid content scripts will result in content errors and will prevent 
your content from being played.CoolSign
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Viewing Where Content is Scheduled

You can quickly view all the channels and players where a selected piece of content is 
scheduled from the Schedule Info tab of the Content Properties dialog.

Retrieving Play History for Content

You can retrieve the play history of one or more selected content items from the Play 
History tab of the Content Properties dialog. Play history provides a summary of the 
number of times a piece of content has played on each player it is scheduled over a period 
of time.
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To retrieve the play history for content:

1. From the Play History tab of the Content Properties dialog, select the View Range for 
which you wish to retrieve the content’s play history. Alternatively, you can manually 
enter the From and To dates, using the date and time editors.

2. Set one or more of the following options:

• To include daily play summaries, check Include day by day breakdown.
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• To only show plays that occurred while the site was open, check Only show logs 

from during site business hours. This option can also significantly increase the 
amount of time required to retrieve the logs.

TIP

For more information on sites and defining site business hours, see “Setting the 
Hours for a Site” on page 210.

• To show all the players on your network, including those on which the content 
didn’t even play, check “Show 0-play Players”.

3. Click the Retrieve Logs button.

NOTE
Retrieving playlogs for view ranges of over a week or for large networks can sometimes 
take a few minutes to complete. 

To export the play history logs to a file:

1. Right-click on the column header of the Play History grid and choose SAVE GRID 
DATA TO FILE...

2. In the Export to File settings dialog, select the File format you would like to export to 
and set any available options.

3. Click OK.

To print the play history logs:

Right-click on the column header of the Play History grid and choose PRINT GRID...
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Using the Attributes Tab

You can define your own custom attributes for content if you want to track specific infor-
mation with each content item. For example, you may want to add a Client field so you can 
track the name of the client within a media advertising network. Attribute fields can be 
displayed within your views in the Content Manager and used within searches or Quick-
Searches.

Using Enabling Expressions

Enabling expressions can be used to dynamically control when a player’s content plays or 
doesn’t play, in other words, determine when or if content plays. You can use enabling 
expressions to tie into dynamic Data Tables, Player Attributes (formerly Node Attributes), 
Content Attributes and Site Properties to create complex behaviors not only from a player 
node level but also from a site-level. The following sources and data tables can be used to 
create these behaviors:

NOTE
Attributes can only be used to help organize and manage content within CNM. You cannot 
access the attributes as dynamic data or to display within content playback.
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To add an Attribute to content:

1. From the Content Properties dialog, click the ATTRIBUTES tab.

2. From the ATTRIBUTES tab on any Content Properties dialog, click the Define 

Attributes button.
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3. In the subsequent Attributes dialog, click the Add button to open a blank Attribute 
Properties dialog.

4. Type a name for the new Attribute.

5. Set one or more of the following options:

• If you want to restrict the options available for input, click the Use picklist check-
box.

• Enter one or more lines of text into the PickList box. Each line of text will appear 
as an option in the picklist when editing a user field.

6. If you want to let users enter their own data in addition to being able to choose from 
the options in your picklist, click the Allow user to enter custom values 
checkbox.Click OK. The new Attribute will be added to all existing and new content.

To attach a player Attribute:

If you want an attribute on your content to match the schema of an attribute on your player, 
you can attach the existing player attributes instead of re-defining it as a new content attri-
bute. This is helpful if you are comparing the values of both attributes in an enabling 
expression, for example, and you want to make sure the schema for both attributes always 
matches.

To edit the value of a custom Attribute for content:

1. From the ATTRIBUTES tab of the Content Properties dialog, edit one or more of the 
Attributes.
CoolSign Network Manager User’s Guide, Version 5.0, Issue 01 131



7. Managing Audio

In addition to the Content page, CNM includes a specialized manager page for working 
with audio-only content. If you plan to use CoolSign to drive an audio-only player or create 
a special audio region on a player, you can use the Audio page to import and manage audio 
content. The Audio page lets you organize your audio content using the more intuitive cate-
gories of Artist, Title, and Album instead of a single content name.

Creating Audio Content 

Unlike standard visual content, you can create the audio content by importing supported 
audio files directly into the CNM Audio page without needing to run them through the 
CoolSign Content Wizard or other tools. When importing an audio file, CNM reads the 
MP3 ID3 tags embedded in the file and uses them to create the audio content in CoolSign.

NOTE
The Audio manager currently only supports MP3 files with ID3v1 tags. Certain applications 
(notably iTunes) only apply IDv2 tags, requiring you to use a third-party application to set 
the ID3v1 on the file.
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To create audio content:

1. Choose ACTIONS > IMPORT AUDIO.

2. Select an MP3 file using the file browser dialog.

3. Click OK to import the MP3 and create audio content.

TIP

You can also directly import MP3 files by dragging and dropping them from the desktop 
into the Audio page grid.

Editing Audio Content Properties

You can edit the properties of audio content on the Audio Properties dialog.
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To edit the properties of audio content:

1. To display the Audio Properties dialog, do one of the following:

• Select the Audio content in the Audio page and choose ACTIONS > EDIT AUDIO 
PROPERTIES.

• Double-click the Audio content in the Audio grid.

• Right-click the Audio content and choose EDIT AUDIO PROPERTIES.

2. Review or change any of the following properties:

Filename—Displays the original audio filename imported into CNM. You cannot 
modify the filename.

Artist, Title, Album, Year—These properties are read from the ID3v1 tags embed-
ded into the MP3 file at import. You can modify these properties as desired.

Duration—The amount of time that the audio content plays for. Entering a duration 
that is less than the actual length of the imported MP3 will truncate playback. Extend-
ing the duration beyond the length of the MP3 will play silence.

File Size—The disk space used by the imported MP3 file.

Volume Gain—Use volume gain to modify the overall volume level of all video, 
flash, or sound assets used in the content. The value can be between -100 and 100, with 
0 being the normal, unmodified volume level of the assets. 

NOTE
You can adjust the overall volume of the player from the player properties dialog. You only 
need to adjust the volume gain if you want to “normalize” the volume of a content item 
relative to the other content.

WARNING

You can only control the volume of SWF files that are version 8 or older. With SWF version 
9 files, it is not possible to control the player volume from CoolSign.

Activation/Expiration Date—You can use the activation and expiration date to set 
when your audio content is able to play back in any channels or playlists. For more in-
formation, see “Setting Content Activation and Expiration” on page 123.

3. Click OK or Apply Changes.

 Viewing Information about Audio Content

You can use the QuickSets, Schedule Info, and Play History tabs to view or retrieve addi-
tional information about how your audio content is organized, scheduled, and how often it 
has played. The use of these tabs is identical to the Content Properties dialog.
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• For more information on managing QuickSets, see “Using QuickSets” on page 35.

• For more information on viewing content schedule info, see “Viewing Where Content 
is Scheduled” on page 126.

• For more information on retrieving content play history, see “Retrieving Play History 
for Content” on page 126.

Scheduling and Playing Audio Content

CoolSign doesn’t treat audio content any differently than standard content in how it can be 
scheduled, transferred or played back other than the fact that audio content does not display 
anything visually when played. 

All audio content is automatically created with the Audio format. You cannot modify the 
format of audio content. 

You can only schedule audio content into channels created with the Audio format and can 
only play back on players or regions set to the Audio format.

Batch Import Audio

1. Right click the grid and then select BATCH IMPORT AUDIO.

2. Import all audio files inside the selected folder.

3. The Select QuickSet dialog appears. From there you can:

• Create a QuickSet.

• Select from an existing QuickSet.

• Don't use a QuickSet.

4. The audio files are imported and are put/or not (depending the selection of step 3) into 
a specified QuickSet.

Make a Playlist

1. Right click a QuickSet and then select MAKE PLAYLIST.

2. The playlist dialog appears with all items inside the quick set. The default name is the 
same as the name of the QuickSet.
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CNM provides great flexibility in how you can schedule your content to appear on your 
CoolSign players. By using CoolSign channels and playlists, you can easily create 
schedules ranging from simple in-order playback. For CNM you can also do complicated 
nested schedules with weighted frequency and dynamic enabling expressions.

About Channels

Channels are the primary tool for scheduling how content will play back on your players. 
Channels are programmed with schedule items that define when and how content will be 
played back. You can schedule individual content items to play in your channel or, for more 
complicated scheduling, you can add playlists, which are sub-schedules of content. Once 
your channel is programmed, you can “tune” as many players as desired to the channel and 
all the necessary content will automatically be downloaded to the player before the channel 
starts playing.

A great advantage of channels is that if you need to change what is playing on your players, 
you can just edit the channel once and all players tuned to that channel will automatically 
be updated. There is no limit to the number of channels that you can create.
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Channels are managed from the Channels page of CNM. For details, see “Managing 
Channels” on page 141.

About Playlists

Playlists are similar to channels except that they are limited to in-rotation items and players 
cannot be tuned directly to them. You can use playlists within channels to provide more 
flexible scheduling than you could otherwise accomplish with just a flat schedule. For 
example, you can use playlists to ensure that multiple content items always play back-to-
back or to cycle through a set of content one at a time.

You can also use playlists to help manage regional or local schedules across large numbers 
of players and sites. For example, you might decide to create a “National” playlist and 
schedule it in all your channels across your CoolSign network. You can then update the 
“National” playlist once and all players in your network would be updated automatically as 
well. Playlists can be nested within other playlists for even more scheduling flexibility.

Playlists are managed from the Playlists page of CNM.
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Channels are the primary tool for scheduling how content will play back on your players. 
Channels allow you to centrally manage all the schedules for a player from one convenient 
page. Rather than scheduling content directly onto a player, you use channels to program 
how content should play and then tune a player to the channel. Multiple players can all be 
tuned to the same channel. If at any point you modify a channel by adding, editing, or 
removing scheduled items, any players that are tuned to that channel will automatically be 
updated with the changes. 

For more information on tuning players to channels, see “Tuning a Player to a Channel” on 
page 178.

Working with Channels

You can use the Channels page of CNM to create new channels, edit or delete existing 
channels, and to program content or playlists within channel.

To navigate to the Channels page:

• Click the Channels icon  in the navigation bar.

To create a new channel:

1. From the Channels page, do one of the following:

•  Choose ACTIONS > NEW CHANNEL.

•  Right-click on the Channels Manager grid and choose NEW CHANNEL.

The Channel Properties dialog appears.

2. Enter a name for your new channel in the Name field.

3. Choose a format for your new channel from the Format combobox. 

If you select either of the Portrait or Landscape format options, only content with the 
same format can be scheduled into the channel, and only players with the same format 
can tune to the channel. For example, you can only schedule portrait content into a por-
trait channel and only portrait players can be tuned to portrait channels.

If you select the ANY option, content and playlists can contain both Portrait and Land-
scape formats.
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NOTE

Once you add items to a channel, you will no longer be able to modify its format. If 
you need to change the format of a channel, delete any scheduled items first.

4. Add content items and/or playlists to the channel. See “Adding Items to a Channel” 
on page 145.

5. Click OK.

To edit an existing channel:

1. From the Channels page, do one of the following:

•  Select the channel and choose ACTIONS > EDIT CHANNEL PROPERTIES.

•  Right-click the channel and choose EDIT CHANNEL PROPERTIES.

•  Double-click on the channel.

2. Change any available properties or add, edit, or remove scheduled items in the 
channel. See “Adding Items to a Channel” on page 145.
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3. Click OK or Apply Changes. Any players tuned to this channel will automatically 
update to reflect changes made to the channel.

To delete a channel:

1. From the Channels page, do one of the following:

• Select the channel and choose EDIT > DELETE. 

• Right-click the channel and choose Delete.

You will be warned before attempting to delete any channels that are currently in use by a 
player.

To create an ANY format channel:

In previous CNM releases, a player’s orientation was set as portrait and landscape. Conse-
quently, players with a certain orientation could only play channels with a matching format. 
For example, a portrait player could only use a channel using portrait format. With this 
release, a new channel format named “ANY” is available to enable you to schedule both 
portrait and landscape content within a channel. Players can be tuned to an ANY channel 
to avoid a format mismatch.

1. Create a new channel.

2. Define the format orientation (in this case ANY).

3. Add content as normal.

4. If you select landscape, the CNM automatically filters out any portrait content. 
Similarly, if you select portrait, all landscape content is filtered out.

Selecting ANY gets you both landscape and portrait content from the content Picker 
window.

NOTE
An “ANY” format channel is designated with angle brackets, for example, <New Channel>.
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About the Channel Properties Dialog

You can use the Channel Properties dialog to modify the properties of a channel and to 
manage the scheduled items programmed to play when a player is tuned to that channel. 
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The Channel Properties dialog contains a collapsible schedule grid that lets you organize 
how your scheduled item will play and visualize the schedule. 

Adding Items to a Channel

When you add content or playlists to a channel, you can set properties that define how the 
scheduled item will play back in the channel including daypart scheduling, activation/expi-
ration dates, and enabling expressions.

To add a scheduled item to a channel:

1. To add content to the channel, select a content item to add. You can select multiple 
items if you want to add more than one item at once with the same scheduled item 
settings.
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2. To add a playlist to the channel, click the PLAYLISTS tab and select one or more 
playlists to add.

3. Click OK to close the Content Chooser dialog and open the Scheduled Items 
Properties dialog.

4. Set any scheduled items properties and the daypart schedule to define how the content 
or playlist will play within your channel. For more information, “About Scheduled 
Items” on page 147.

5. Click OK.

To add non-in-rotation schedule items (recurring, timed, or triggered):

1. Add any desired in-rotation content. See “Adding and Editing an In-Rotation 
Schedule Item” on page 148. for details.

2. Edit the in-rotation item and then change the schedule type from the content 
properties window.

To change an in-rotation schedule item:

1. Select a schedule item and then press Edit. 

2. From the Schedule Item Properties window, set the desired schedule type from the 
pull-down menu. 
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About Scheduled Items

You can use the Scheduled Item Properties dialog to define how an item will be played back 
in a channel. Set advanced properties including activation/expiration date and enabling 
expression, and to override dynamic data bindings for that scheduled instance.

There are five ways that scheduled items can be played within a channel:

In-rotation (“Adding and Editing an In-Rotation Schedule Item” on page 148)—This 
is the most common way to schedule content or playlists in a channel. A channel repeatedly 
plays its in-rotation items unless one of the specialized schedule items described below 
takes precedence. You can choose the order in which in-rotation items are played back by 
setting the channel or playlist picker type. The in-rotation picker can be set to play back 
items in order, shuffled or randomly using a weighted frequency. Each in-rotation item can 
additionally be set with a daypart schedule that enables or disables the item during specific 
hours or days of the week and activation/expiration dates that define when the item should 
start and stop playing. 

. Recurring (“Adding a Recurring Scheduled Item” on page 151)—You can use this 
schedule type to schedule content to play at regular repeated intervals, for example, every 
15 minutes or every hour. A recurring item can be set to either interrupt playing content 
when it’s time for it to play or to wait politely for the playing content to end before starting. 
Like In-rotation items, you can set a daypart schedule to only enable the recurring item 
during specific hours of the day.
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Timed (“Adding a Timed Scheduled Item” on page 153)—When you want content to 
play once at a specific time on a specific date or day of week, you can use this schedule 
type. Like recurring items, timed items can be set to interrupt playing content at the play 

time if desired. 

Triggered (“Adding a Triggered Scheduled Item” on page 154)—Content that is 
scheduled using the triggered type only plays when triggered via the CNM trigger manager 
or an external data source.

Merged (Playlists only) (“Adding a Merged Scheduled Item” on page 155)—Merged 
playlists treat the scheduled items of a playlist as if they were directly added to the channel. 
This enables you to take advantage of the organizational advantages of using playlists while 
retaining full flexibility for scheduling. The “Merged” schedule-type does not appear in the 
Scheduled-Type drop-down list of the Scheduled Item Properties dialog unless Playlist 
content is added.

Adding and Editing an In-Rotation Schedule Item

In-rotation scheduled items are the most common way to add items to a channel. You can 
set a daypart schedule for in-rotation items. For CNM you can also set a frequency setting 
if the channel is using the Weighted Frequency picker (“Setting the In-Rotation Playback 
Order” on page 150).

You can add in-rotation scheduled items to a channel. For example, a day-part schedule for 
in-rotation items as well as a frequency setting if the channel is using the Weighted 
Frequency picker. (See “Setting the In-Rotation Playback Order” on page 150.)

To add an in-rotation scheduled item:

1. Click the Add in-rotation item button.

2. Select a content item.

3. An item is added to the channel with default values, such as frequency and 
activation/expiration settings, etc.

4. Select Edit item to edit any in-rotation properties.
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To set schedule item properties:

1. The default setting is to use the Weighted Frequency picker. You can set the relative 
frequency of the in-rotation item from 1 to 10. For more information on pickers, 
“Setting the In-Rotation Playback Order” on page 150.

2. Define the times and days for which the scheduled item should be played. The blue 
cells of the schedule grid indicate that the item will be played in rotation with any 
other active scheduled items. The white cells indicate that the item will not play. For 
more information, “Using Schedule Grids” on page 312. 

3. Set any activation or expiration dates for the scheduled item. For more information, 
“Setting Advanced Properties” on page 156.

NOTE

The "Use local time" or "Use UTC time" selected above doesn't affect the activation 
and expiration dates.
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4. If you have selected dynamic content and want to override the data bindings for this 
scheduled item only, click the DYNAMIC DATA tab. For more information, see 
“Overriding Dynamic Data Settings” on page 187. 

5. Click OK to add the scheduled item to the channel.

Setting the In-Rotation Playback Order

To determine the order in which in-rotation scheduled items should play back within a 
channel, you can choose one of the following playback algorithms:

Weighted Frequency—The default picker that uses a frequency value assigned to each 
scheduled item to determine which item should play next. Items with higher frequency play 
more often than items with a lower frequency. The frequency value for a scheduled item 
represents its relative frequency when compared with other items in the channel.

In Order—Any active in-rotation items are played back in the order they appear in the 
Channel grid.

NOTE
You can reorder scheduled items in the channel grid by clicking and dragging the item to a 
new position.

Shuffled—Randomly shuffles all the in-rotation scheduled items and plays them back in 
the random order. All the items play back before the list is shuffled again. This algorithm 
ensures that the same scheduled item never plays back-to-back. Note that if there is only 
one item, then it has to play back-to-back.

In addition, you can either allow or not allow back-to-back playback when using the 
Weighted Frequency option. These options are set through the CNM (CHANNEL DIALOG > 
ADVANCED TAB). See “Advanced Playback Settings” on page 173. 

When set to "do not allow back-to-back", the weighted frequency option cannot be 
completed. For example, if there are two In-rotation items, item 1 has frequency as 1 and 
item 2 has frequency as 10. Normally, item 2 should play 10 times when item 1 plays only 
once. But if you set "do not allow back-to-back", then the result is that item 1 and item 2 
CoolSign Network Manager User’s Guide, Version 5.0, Issue 01 150



9. Managing Channels 
Adding Items to a Channel
plays alternatively, which means their actual frequency numbers are the same in order to 
avoid back to back play.

TIP

 Due to the randomness inherent in the weighted frequency picker, it is impossible to 
predict exactly how often an item will play, but you can view an approximate estimate on 
the Scheduled Items Properties dialog.

NOTE
 When fewer than seven items are scheduled using the Weighted Frequency picker, the 
picker allows items with higher frequencies to play back to back to preserve the relative 
frequency ratios.

To select the in-rotation playback order:

• Select the playback order type in the In-Rotation Items area of the Channel Properties 
dialog (“About the Channel Properties Dialog” on page 144).

Adding a Recurring Scheduled Item

Recurring scheduled items can be set to play back content on a repeating interval. You can 
set properties related to the recurring interval as well as a schedule of the times and days of 
the week for which the item is active.

To add a recurring scheduled item:

1. Follow the steps to add an new scheduled item to the channel. See “Adding Items to a 
Channel” on page 145. for details.

2. In the Scheduled Item Properties dialog, expand RECURRING and then right click to 
add an item from the Scheduled Type box.
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3. Once selected, define how often you want the scheduled item to repeat by setting the 
hours and minutes values.

NOTE

A recurring item will play after each repeat interval starting at midnight. If you want to 
offset when the recurring item plays, use the schedule grid to change the time when 
the item becomes active. For example, if you want an item to play every hour on the 
half hour, you would set the repeat interval to 1 hour and modify the schedule so that 
the item becomes active at 12:30am.

4. If you want the scheduled item to play exactly at the defined recurring interval, even 
if that would require interrupting content that is currently playing, check “Interrupt 
playing content”. Non-interrupting scheduled items will be queued to play 
immediately after the currently playing content.

5. Define the times and days for which the scheduled item should be played. The blue 
cells of the schedule grid indicate that the item is active and the white cells indicate 
that the item will not play. See “Using Schedule Grids” on page 312.

6. Set any advanced properties for the scheduled item. For more information, “Setting 
Advanced Properties” on page 156.

7. If you have selected dynamic content and want to override the data bindings for this 
scheduled item only, click the DYNAMIC DATA tab. For more information, see 
“Overriding Dynamic Data Settings” on page 187.

8. Click OK to add the scheduled item to the channel.
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Adding a Timed Scheduled Item

Timed scheduled items play back once at each timed interval. You can set timed items to 
play back every day or on specific days at a defined time or once on a certain date and time. 
Because timed scheduled items inherently define when they play, you cannot set a daypart 
schedule for them.

To add a timed scheduled item:

1. Follow the steps to add an new scheduled item to the channel. See “Adding Items to a 
Channel” on page 145. 

2. In the Scheduled Item Properties dialog, select Timed from the Scheduled Type box.

3. Click Add to define a time when the timed item should play. You can specify days of 
the week when the timed item should play or set an exact date and time when the 
timed item should play one time only. 

NOTE

To add multiple times for a schedule item, click the Add button again.
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4. If you want the scheduled item to play exactly at the defined time(s), even if that 
would require interrupting content that is currently playing, check “Interrupt playing 
content”. Non-interrupting scheduled items will be queued to play immediately after 
the currently playing content. Note that you can choose to use either local time or 
UTC time. By default, the time specified here uses UTC time.

5. Set the activation date and expiration date for the scheduled item. For more 
information, “Setting Advanced Properties” on page 156.

NOTE

“Use local time” or "Use UTC time" if either was previously selected, doesn't affect 
the activation and expiration dates.

6. If you have selected dynamic content and want to override the data bindings for this 
scheduled item only, click the DYNAMIC DATA tab. For more information, see 
“Overriding Dynamic Data Settings” on page 187.

7. Click OK to add the scheduled item to the channel.

Adding a Triggered Scheduled Item

Triggered scheduled items are played whenever the assigned trigger is fired via an external 
application or manually from the Manage Triggers dialog. You can select a trigger for the 
schedule item, along with specific times and days of the week when the item is active.

To add a triggered scheduled item:

1. Follow the steps to add a new scheduled item to the channel. See “Adding Items to a 
Channel” on page 145. for details.

2. In the Scheduled Item Properties dialog, select Triggered from the Scheduled Type 
box.

3. Select a trigger in the Trigger combobox or click Create New Trigger. For more 
information on triggers, see 20. "Managing Triggers", on page 316

4. If you want the scheduled item to play immediately when it is triggered, even if that 
would require interrupting content that is currently playing, check Interrupt playing 

content. Non-interrupting scheduled items will be queued to play immediately after 
the currently playing content.

5. Define the times and days for which the scheduled item can be triggered. The blue 
cells of the schedule grid indicate that the item is active and the white cells indicate 
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that the item will not play. For more information, see 19. "Using Schedule Grids", on 
page 312.

6. Set the activation and expiration date for the scheduled item. For more information, 
“Setting Advanced Properties” on page 156.

7. If you have selected dynamic content and want to override the data bindings for this 
scheduled item only, click the Dynamic Data tab. For more information, see 
“Overriding Dynamic Data Settings” on page 187. 

8. Click OK to add the scheduled item to the channel.

Adding a Merged Scheduled Item

Merged scheduled items are a special type of scheduled item that can only be used with 
playlists. A merged playlist schedule item treats the items in a playlist as if they had been 
added directly to the channel.

For example, you could create a “National” playlist and schedule it as merged within all of 
your channels. The items in the “National” playlist would play back as if scheduled directly 
within each channel except that you could update items centrally from within the playlist 
without having to edit each channel. 

For more information on playlists and scheduling strategies, 10. "Managing Playlists", on 
page 169.

To add a merged scheduled item:

1. Follow the steps to add a new scheduled item to the channel remembering to select 
from the Playlists tab rather than the default Content tab of the Content Chooser. See 
“Adding Items to a Channel” on page 145. for details.

2. In the Scheduled Item Properties dialog, select Merged from the Scheduled Type 
box. 

NOTE

Merged is only available as an option when you are adding a playlist to the channel. 
You cannot set the Merged scheduled type for content or audio.

3. Set any activation or expiration dates for the scheduled item. For more information, 
“Setting Advanced Properties” on page 156.

4. Click OK to add the scheduled item to the channel.
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To merge playlists playback constraints:

1. The playback order of a merged playlist must match the parent schedule.

2. Once a schedule (channel or playlist) contains a merged playlist, you cannot change 
the schedule’s playback order.

Setting Advanced Properties

You can set activation and expiration dates for scheduled items from the Advanced Prop-
erties dialog.

Setting Scheduled Item Activation and Expiration Dates

If you want a scheduled item to start or stop playing at some future date and time, you can 
set the activation date and expiration date for the item. Items will not become active until 
their activation date and will be indicated with a Pending status. Items set with an expiration 
date will immediately stop playing at their expiration date and time. 

NOTE
Activation and expiration dates are evaluated based on the local time zone of the player. 
For this reason, expired scheduled items are not automatically deleted from a channel 
until 24 hours after the expiration date to ensure that the content continues to play in all 
time zones until the local expiration date is passed.

TIP

Activation and expiration dates for scheduled items are applied to the current channel 
only. If you want to globally activate or expire content everywhere that it is scheduled, you 
can set Content Activation and Expiration dates from the Content Properties dialog.

To set the activation date of a scheduled item:

1. Click the Activates At radio button.

2. Click the ACTIVATION DATE EDITOR drop-down to edit the activation date at which the 
item can start playing.
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To set a scheduled item to be active now:

• Click the Activates Now radio button.

To set the expiration date of a scheduled item:

1. Click the Expires At radio button.

2. Click the Expiration Date Editor drop-down to edit the expiration date at which the 
item should stop playing.

To set a scheduled item to never expire:

• Click the Expires Never radio button.

Setting Enabling Expressions

Enabling expressions can be used to dynamically control when a player’s content plays and 
under what conditions it plays. With this release, you can now use enabling expressions to 
tie into dynamic Data Tables, Player Attributes (formerly Node Attributes), Content Attri-
butes and Site Properties to create complex behaviors not only from a player node level but 
also from a site-level. The following sources and data tables can be used to create these 
behaviors:

Player Attributes—(formerly called Node Attributes) Can be displayed within your views 
in the Content Manager and used within searches or QuickSearches. For more details, see 
“About Node Attributes” on page 298.

Content Attributes—Users create their own content attributes in user fields such as 
language, company regions, store departments, etc. These attributes are tied to a player’s 
content at the “site level” and can be used to track additional data about each site that is 
relevant to your business.

Site Properties—Contains geographic information (locations, addresses, etc.) For more 
details, see “Creating a New Site” on page 207.

Data Tables—Mini-databases with a structure that is flexible enough to allow you to store 
anything from a single piece of information to a complex table with dozens of fields and 
hundreds of records. For more details, see “About Data Tables” on page 213.

Source Attributes are 
enclosed with [ ].
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NOTE
The enabling expression is evaluated each time a scheduled item is “supposed” to play. If 
it evaluates to true, the scheduled item plays back as scheduled; otherwise, the item does 
not play. For example, if you have a data table that contains the local weather for a player, 
you could use an enabling expression to play back content for umbrellas only in case of 
rain.

Enabling expressions can only be used to enable/disable an item from playing back as it is 
scheduled. You can’t use enabling expressions to force items to play. To force items to play 
based on external data, 20. "Managing Triggers", on page 316.

To add or edit an enabling expression:

1. Double click an item in a channel and open the Schedule Item Properties dialog.

2. Click the Enabling Expression tab.

Following is a basic enabling expression that you can set up to evaluate against "Rain" 
being in the "Condition" field of the data table "Weather." The intent is for the umbrella 
advertisement to play each time it rains.
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A more complex enabling expression can be setup as follows. In this case, a Player attribute 
“Language” is compared to a Content attribute “Language”. The intent is for an “English” 
player to play its content each time these two attributes match.

A simpler enabling expression for “Language” can also be setup. In this case, a Player 
attribute “Language” can be setup.

“Rain” appears in the 
Value box.

Select the Condition 
“Equals”

Select Data Table 
“Weather”

Select the Condition 
“Equals”

Player Attri-
bute “Lan-
guage”

Content Attri-
bute “Lan-
guage”
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Two things to remember when setting up Player attributes and Content attributes:

• Player attributes defined at the player node level will always override Site-level at-
tributes when used in enabling expressions.

• If a Player Attribute is undefined at the Player Node level, it inherits values defined 
at the Site level.

If desired, check “Use advanced editor” if you want to review the actual JavaScript used 
for the enabling expression or if you want to hand-edit the expression to add additional 
logic to the expression. For more information on accessing dynamic data through JavaS-
cript expressions, see the Content Scripting technical documentation provided with your 
software.

To clear an enabling expression:

• Click the Clear Expression on the Enabling Expression tab.

Player Attribute 
“Language”

Note that in this case the “Picklist” values 
have been automatically populated.
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Determining when a Channel Can Start Playing

When you tune a player to a new channel, CoolSign automatically starts transferring the 
content required by the channel down to the player. Depending on the speed of your 
network and the number and size of the content files required for the channel, this can take 
anywhere from a few seconds to hours. For each channel, you can decide if you want the 
player to start playing items in the channel as soon as they are available or if you want the 
player to continue playing the current channel (or black if there is no channel) until all the 
items have transferred.

To mark a channel to wait for all items before playing:

• On the Channel Properties dialog, check “Wait for all items before playing”. 

TIP

You can review the transfer status of the items in a channel to a player from the Player 
Properties dialog or the Transfers tab of the Node Properties dialog for the player node.

Working with the Channel Grid

The channel grid on the Channel Properties dialog displays all of the items scheduled in the 
channel. For organization purposes, each type of a scheduled item is listed in its own 
collapsible area so you can easily view all types of items or just focus on the items in which 
you are interested in. The channel grid displays the most common properties of each 
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scheduled item as well as a graphical timeline of the item’s schedule.

Using Scheduled Item Collapsible Areas

Each type of scheduled item has its own collapsible area in the channel grid. You can 
expand or collapse each area to view or hide the scheduled items. When you first open a 
Channel Properties dialog, only the collapsible areas with one or more scheduled items are 
expanded. The other areas are collapsed.

To expand a collapsed scheduled item type area:

• Click to expand a collapse area.

TIP

To automatically collapse any other open areas, hold down the Ctrl key while expanding 
an area.
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To resize an open area:

1. Move the mouse to the area between the two areas you want to resize.

2. When the cursor changes to , click and drag vertically to resize the areas.

Understanding the Channel Grid

To help you quickly identify the properties of scheduled items, the channel grid provides 
visual feedback in the form of icons, colors, and the graphical timeline. Depending on the 
properties of your scheduled items, you might see one of more of the following icons:

Active content items scheduled in the channel.

Active playlists scheduled in the channel.

Content that becomes active in the future due to a scheduled item or content activation 
date being set.

Content that has expired due to a scheduled item or content expiration date being set.

Content that has been disabled by checking the Disable this scheduled item from 
playing on the Scheduled Item Properties dialog.

Indicates a scheduled item for which an enabling expression has been set.

Setting Activation and Expiration Dates from the Channel Grid

You can set the activation and expiration date for a scheduled item without opening its 
Scheduled Item Properties dialog. To do so, the date directly in the grid.

To edit a scheduled item’s activation or expiration date:

1. Click the activation (Starts) or expiration (Stops) date from the Channels grid.

2. Select a new date and time to use for activation or expiration or click Activates Now 
or Expires Never to remove the activation or expiration date.

NOTE
If the scheduled content has an activation or expiration date set from the Content 
Properties dialog, the activation and expiration dates will appear in red. A content item’s 
activation and expiration dates always take precedent over a scheduled item’s. You 
cannot set the scheduled item’s activation or expiration date outside the range defined by 
the content, but you can set it later or earlier.
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Editing Content Properties

You can open the Content Properties dialog for any content scheduled in your channel if 
you want to quickly view or edit settings for the content.

To edit content properties for a scheduled content item:

• Right-click on the scheduled item and choose EDIT CONTENT PROPERTIES.

Showing Content Thumbnails

You can view the thumbnails for content in your channel.

To display content thumbnails in the channel grid:

• Right-click in any column header and choose SHOW THUMBNAILS.

Working with the Timeline View

The graphical timeline in the channel grid visually displays when a scheduled item is active 
across a span of weeks. You can configure the timeline to show from one to eight weeks 
and to calculate the total loop duration of scheduled content. You can also directly modify 
a scheduled item’s activation and expiration dates by clicking and dragging within the 
timeline.

Understanding the Timeline

The timeline indicates the active state of the content during the current week and for two to 
eight weeks into the future. 

The following colors and patterns are used to indicate the active state of an item:

Use these arrow buttons to move 
to the previous or next week.

Right-click the date to directly 
select a week to display.

Click the Options menu 
to set additional options 
to configure the timeline.

The checkerboard pattern indicates 
that the content is not active or has 
expired on these days.

Indicates that this 
week has an overrid-
den daypart schedule.

You can drag the han-
dles to change the 
activation/expiration 
dates for an item.

This pattern rep-
resents the dayp-
art schedule for 
the item.
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Solid blue—Indicates that the schedule item is active during the displayed days for the 
entire day.

White—Indicates that the item is not active on this day due to an activation or expiration 
date on the item.

Blue/gray pattern—Represents the daypart schedule for an item.

Checkerboard—Indicates that a content item is not active on this day because activation 
or expiration dates were set on the item itself.

Yellow—Weeks for which a scheduled item’s daypart schedule has been overridden.

Selecting the Displayed Weeks

By default, the timeline view displays the current week along with the number of future 
weeks set in the View options menu. You can select other weeks to view the timeline.

To change the visible week:

1. Right-click the week label to open the Week Selector Calendar.

2. Select a day in the week you want to display in the timeline.

To navigate to the next or previous week:

• Click the left or right arrows to navigate to the previous or next week.
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To change the number of displayed weeks:

1. Click Options to open the VIEW OPTIONS menu.

2. Set the number of visible weeks from 1 to 8.

Showing Timelines

This option is for loading channel dialog quickly for very complex schedules. Uncheck 
“Show timeline” if you don’t want the timeline section displayed. Note that if “Show 

timeline” is unchecked, the remaining view options are disabled.

Viewing the Loop Duration

If you are interested in managing the total duration of the In-Rotation items scheduled in a 
channel, you can use the Loop Duration panel. You can check the total duration of all 
content scheduled in-rotation by day. You can also set a minimum and maximum loop 
duration to receive visual indication of when the duration of your loop exceeds or is under 
your settings.

To display the Loop Duration panel:

1. Click Options to open the VIEW OPTIONS menu.

2. Check Show Loop Duration.

Click to open 
the Loop menu.

Yellow indicates that the 
total loop length is less 
than the minimum set in 
the loop menu.

Blue indicates that the 
total loop length is 
within the min and max 
set in the loop menu.

Red indicates that the 
total loop length is longer 
than the maximum set in 
the loop menu.
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To set the Max Loop and Min Loop settings:

1. Click Loop Duration to open the LOOP menu.

2. Set the minimum duration in seconds that you want your loop to play. If your loop 
length is less than this value, the Loop Duration panel will display a yellow warning 
color.

3. Set the maximum duration in seconds that you want your loop to play. If your loop 
length is greater than this value, the Loop Duration panel will display a red warning 
color.

Cutting, Copying, and Pasting a Channel’s Scheduled Items

You can cut, copy, and paste scheduled items to different channels or you can copy just the 
schedule properties from a scheduled item and apply it to another scheduled item. When 
you copy and paste a scheduled item, you are duplicating the entire scheduled item 
including the content or playlist that is scheduled. When you just copy an item’s schedule 
properties, you are only copying the settings for the scheduled item and can then apply 
those settings to another scheduled item without changing the content or playlist that is 
scheduled.

To cut or copy a channel’s schedule item(s) to another channel:

1. Open the source Channel Properties dialog.

2. Select the scheduled items to be copied using:

• Ctrl-C to copy or Ctrl-X to cut.

• Right-click and choose CUT or COPY.

To paste a channel’s schedule item(s) to another channel:

1. Open the target Channel Properties dialog.

2. Paste on the scheduled items grid by:

• Enter Ctrl-V or right-click.
CoolSign Network Manager User’s Guide, Version 5.0, Issue 01 167



9. Managing Channels 
Overriding Playlist Scheduled Items
Overriding Playlist Scheduled Items

You can override the properties of the items within a playlist scheduled within a channel. 
Playlist overrides are applied only for the channel in which you create the override and not 
anywhere else the playlist is used.

For more information on overriding scheduled items, “Overriding Channels” on page 184.

Reviewing where a Channel is Used

You can quickly view which players have been tuned to a channel from the Players tab of 
the Channel Properties dialog.

For details, “Tuning a Player to a Channel” on page 178.
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Playlists add additional flexibility when programming your channels by providing the 
capability to create “sub-schedules” within the channel’s schedule. You can also use 
playlists to help in “localizing” your schedules across multiple sites and players. Playlists 
are similar to channels with the following differences:

• You can only add In-Rotation scheduled items to a playlist.

• You can’t tune a player to a playlist. You must schedule a playlist within a channel.

• Playlists can be scheduled within other playlists.

Working with Playlists

You can manage the playlists in your network from the Playlists manager page of CNM. 
From the Playlists page, you can create new playlists, edit or delete existing playlists, and 
program content within your playlists.

To navigate to the Playlists page:

Click the Playlists icon in the navigation bar.

To create a new playlist:

1. From the Playlists page, do one of the following:

• Choose ACTIONS > CREATE NEW PLAYLIST.

• Right-click on the PlayList Manager grid and choose CREATE NEW PLAYLIST.

• In content or audio manager, right click on a quickset and then select MAKE PLAY-
LIST.

• On the Channel and Playlist dialogs, select one or more schedule items and then 
select "Make Playlist from selected items".

The Playlist Properties dialog appears.

2. In the Name field, enter a name for your new playlist.
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3. Choose a format for your new playlist from the Format combobox. Only content with 
the same format can be scheduled into the playlist, and only channels with the same 
format can schedule the playlist. 

NOTE

Once you add items to a playlist, you can no longer modify its format. If you need to 
change the format of a playlist, delete any scheduled items first.

4. Add content items and/or other playlists to the playlist. See “About the Playlist 
Properties Dialog” on page 171. 

5. Click OK.

To edit an existing Playlist:

1. From the PlayList page, do one of the following to display the PlayList Properties dia-
log:

• Select the channel and choose ACTIONS > EDIT PLAYLIST PROPERTIES.

• Right-click the channel and choose EDIT PLAYLIST PROPERTIES.

• Double-click on the playlist.

2. In the Playlist Properties dialog, change any available properties or add, edit, or 
remove scheduled items in the channel. See “About the Playlist Properties Dialog” on 
page 171. 

3. Click OK or Apply Changes. Any channels using this playlist will automatically 
update to reflect the changes.

To delete a playlist:

• Select the playlist and choose EDIT > DELETE or right click to select a playlist and then 
select Delete. 
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About the Playlist Properties Dialog

You can use the Playlist Properties dialog to set or modify the properties of a playlist, add 
scheduled items to the playlist, and review which channels currently use the playlist. The 
Playlist Properties dialog is very similar to the Channel Properties dialog.

Adding Items to a Playlist

The process for adding items to a playlist is identical to adding items to a channel except 
that you can only add In-Rotation scheduled items.

For more information on adding items to a channel, see “Adding Items to a Channel” on 
page 145.

Scheduling a Playlist in a Channel

Playlists can be scheduled into a channel (or other playlists) with all the same properties as 
a piece of content. You can schedule a playlist as In-rotation, Recurring, Timed, or Trig-
gered. Playlists can have daypart schedules, activation/expiration dates, and enabling 
expressions just like content. However, when it comes time for a playlist to “play”, the 
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channel lets the playlist pick which content or playlist should play, based on the items 
scheduled within the playlist and its own playback order settings.

Determining how a Playlist Plays

Just as with a channel, you can set the playback order for a playlist using the Playback order 
combobox. For more information on setting playback order, see “Setting the In-Rotation 
Playback Order” on page 150.

Additionally, you can define whether the playlist should just play one item or all the items 
each time it is picked to play by its parent channel. 

Play One Item—When a playlist is set to Play One Item, it will play one item picked from 
its scheduled items. After playing the one item, it will return control to the parent channel 
or playlist.
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Play All Items—When a playlist is set to Play All Items, it will play all of its scheduled 
items before returning control to the parent channel or playlist.

About Merged Playlists

In addition to the four standard types of scheduled items, you can also schedule a playlist 
as merged within a channel. When a playlist is merged with a channel, the items within the 
playlist are treated just as if they were added directly to the parent channel. The parent 
channel selects scheduled items to play using both the scheduled item added directly to the 
channel and the items within the merged playlist. This feature allows you to manage sub-
sections of a channel separately and share them across multiple channels. 

NOTE
The playback order settings for a playlist are ignored when the playlist is scheduled as 
merged.

Advanced Playback Settings

You can use the Playlist Properties dialog to evaluate channels that contain multiple 
instances of a dynamic content item. Two evaluations are available via the Advanced tab 
in the Playlist Properties dialog.

Data Context Sharing—The default for this setting is to have the “next” data row used 
each time it plays so the context of “where are you in the list” is maintained for the entire 
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channel. Alternately, if unchecked, the dynamic content maintains “independent” contexts 
and as such plays the same row from within the data table.

Picker Context Sharing—The default for this setting is to have the “next” playlist item 
used each time it plays so the context of “where are you in the list” is maintained for the 
entire channel. Alternately, if unchecked, the playlists maintain “independent” contexts and 
as such plays the same item from within the playlist (if they’re reset to in-order).

Localizing Schedules

If your network contains a large number of sites or players, you may find that, while each 
player or site has some unique content playing on it, there is also a large amount of content 
that should be played across all the sites as well. You can use playlists to optimize your 
schedules so you can manage a large number of channels across a large number of players 
but still easily add content to the entire set or a subset of channels. 

For example, if you are using CoolSign for a national advertising network, you may have 
national content that needs to play across your entire network, regional content that only 
plays on the West Coast, and specific content that plays at each site. By using merged play-
lists, you can build up channels for each player or site that can contain both the player-
specific content items as well as a National and/or Regional merged playlist you have 
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defined. By scheduling the National playlist into every channel used by every player, you 
can now quickly add or remove scheduled items from every player by just editing the 
National Playlist once. 
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The Players page of the CoolSign Network Manager (CNM) lets you view all the CoolSign 
players connected to your network. You can do any of the following on the Players page:

• Tune a player to a channel.

• Review both detailed and rollup play history for a player.

• Set a schedule for the volume level of a player.

• Remotely configure the player, including defining multiple regions and display 
control.

• View the current status of both the player and any displays connected to the player.

• View the current content that is now playing on the player.

• Organize the players by geographic distribution, using the Sites panel.

• Create QuickSets and QuickSearches to filter which players are visible in the grid.

• Force content to play immediately on the player.

About Players and Channels

The CNM uses a channel metaphor for scheduling content to play back on your players. 
You create channels and then program content and playlists within each channel. Once your 
channels are designed, you can then tune players to that channel. 

Once you tune a player to a channel, the CNM automatically takes care of everything 
required to distribute the content, playlists, and data tables to the player. The CNM checks 
to see which files need to be transferred and immediately starts sending them across your 
network to each player. Depending on the settings of the channel, items in the channel can 
start playing as soon as they are available, or the player can wait for all the items in the 
channel to be available before switching to the channel.

If you modify a channel by adding new scheduled items, editing existing scheduled items, 
or removing items, those changes are automatically distributed to any players tuned to that 
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channel. If a player happens to be offline when the changes are made, the CNM distributes 
the changes as soon as the player reconnects to the network.

NOTE
While each player can only be tuned to a single channel at a time, any number of players 
can be tuned to the same channel. This enables you to update a single channel and have 
those changes automatically applied to all the players tuned to that channel.

For more information on working with channels, see “Managing Channels” on page 141 for 
details.

About the Player Properties Dialog

You can use the Player Properties dialog to tune a player to a channel, review play history, 
and schedule volume control.

To edit the properties of a player:

Do one of the following:

• Double-click on the player in the grid.

• Select one or more players and choose Actions > Edit Player Properties or right-click 
and choose Edit Player Properties.
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Tuning a Player to a Channel

You can use the Player Properties dialog to tune a player to the channel it should use to play 
back content. The Player Properties dialog displays the currently tuned channel, using the 
same grid as appears on the Channel Properties dialog. 

For more information on working with channels and the channel schedule grid, 8. "About 
Scheduling", on page 139.

To tune a player to a channel:

1. Select a new channel from the Tune to channel drop-down menu (“To edit the proper-
ties of a player:” on page 177). The channel grid is updated to reflect the new channel.

2. Click OK or Apply Changes. Any needed files will immediately begin transferring to 
the player.

NOTE
To tune multiple players to the same channel at the same time, select multiple players 
before opening the Player Properties dialog.
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Reviewing a Channel Before Tuning

Before you commit to tuning a player to a channel, you can see what the channel contains 
as well as which content items in the channel will need to be transferred to the player before 
they can play.

The status of each item in the proposed schedule can be either of the following:

 Available—The content item is already available on the local player hard disk 
and will not require any transfer to play.

Transfer required—The content must be transferred to the 
player before this item can be played. If the channel is marked as “Wait for all items before 
playing”, the player will not switch to the new channel until all needed content has been 
transferred to the player.

NOTE
All content in a tuned channel will be transferred to a player regardless whether it is 
currently active or pending activation due to the setting of a future activation date on the 
content or schedule item. This feature allows you to “stage” content on the player at the 
time you tune it so that you can be assured that the content is available when it comes 
time for it to play.

Viewing Transfer Status of Items to a Player

When you tune a player to a channel, all of the content, playlists, data tables, and files 
required to play that channel will automatically start transferring to the player. If, at any 
point, you modify either the channel or any content or playlists included in the channel, any 
changes will also be automatically transferred to the player for you. 

The status of each transferring item can be any of the following:

Checking—Either a transfer has not yet started and the system is checking 
to see if it is necessary to transfer content to the player or CNM is still waiting for the server 
to send an updated transfer status report.

The transfer bar displays the current progress of a transfer to a player. 

An all-green transfer bar indicates that all necessary files for the content 
have been transferred to the player but that the content has not been loaded yet. You may 
see this status temporarily when the channel is marked to “Wait for all items to transfer 
before playing” or when there are additional files required for the content to play, for 
example, data tables with imported media files that have not yet completed transfer.

During the transfer, the Player Properties dialog shows the progress of the entire transfer 
required for the player:
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Viewing the Status of Scheduled Items on a Player

Once all the necessary files required to play back content have been transferred to the 
player, the content will be loaded and should start playing back as scheduled. There are a 
number of reasons why content that has been scheduled and transferred to a player might 
not be actively playing. Once a content item has been transferred to the player and loaded, 
you can review its current status in the status column of the Player Properties dialog.

The status of each loaded item can be any of the following:

Ok—The content is loaded and should be playing back as scheduled.

Ok (Pending)—The content is loaded but is pending a future activation 
date, either set in the schedule item or the content.

Ok (Expired)—The content is loaded but has expired due to a past expiration 
date set in the schedule item or content. Expired items are automatically deleted from a 
channel after 24 hours.

Inactive—The schedule item has been disabled from the Schedule Item Prop-
erties dialog.

Error—A problem occurred while the content was playing back. The status 
includes additional information about the type of error and the version of the content which 
is playing. For more information on content errors, see “Troubleshooting display errors” on 
page 384.

TIP

If the status column is not wide enough to see the entire error status message, you can 
hover the mouse over the column to see a tool tip, which displays the full contents of the 
field.

Offline—The entire player is currently offline.

Quick Tuning a Player to a Channel

You can quick tune a player (or players) directly to a channel without using the Edit Player 
Properties dialog. When using this feature, all players (or nodes) that are currently high-
lighted are automatically tuned to the desired channel(s). 
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To quick tune a player or player node:

1. From the Player Manager, select QUICK TUNE...

2. From the Quick Channel Tuner dialog, select a channel (or channels) to which you 
want to tune the selected players.

NOTE
Channels that have angled brackets are in “ANY” format.
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3. Click OK.

Jump to Node

If you have multiple player nodes, you can use the Jump to Node feature to display the node 
for a specific player in the CoolSign Network Manager. Once selected, this node appears 
in the Network Manager along with the filter that was created in the Quicksets dialog.

To filter on a specific player node:

1. From the Players Manager, highlight the desired player node and select Jump to Node 
(see “Quick Tuning a Player to a Channel” on page 180 for details).

2. From the Network Manager, configure the player node as desired.

Modifying channels

While you will usually create and edit channels from the Channels page, the Player Prop-
erties dialog provides some shortcuts to help you manage the available channels.

Creating a New Channel

You can create a new blank channel directly from the Player Properties dialog and tune the 
player to it in one step. 

To create a new channel:

1. Click New Channel to open a new Channel Properties dialog (“To edit the properties 
of a player:” on page 177).

2. Enter a name for the new channel and add schedule items as desired. For more 
information on working with channels, see 19. "Using Schedule Grids", on page 312.

3. Click OK. 

Editing the Currently Tuned Channel

If you want to make changes to the currently tuned channel, you can do so directly from the 
Player Properties dialog without having to close the dialog and navigate to the Channels 
page.

NOTE
Changes you make to a channel will be applied to every player that is tuned to that 
channel. If you want to make changes to a channel for the current player only, refer to 
“Overriding Channels” on page 184.
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To edit the current channel:

1. Click Edit Channel to open a Channel Properties dialog for the currently tuned chan-
nel (see “To edit the properties of a player:” on page 177).

2. Make any desired changes to the channel.

3. Click OK. Any changes made to the channel will automatically start transferring to 
the player.

Viewing Play Logs

You can retrieve the play history for a specific piece of content from the Content Properties 
dialog (see “Retrieving Play History for Content” on page 126) but if you want to review 
all of the content that played on a player, you can use the Play logs tab of the Player Prop-
erties dialog.

Viewing Play Summaries for a Player

You can retrieve rolled-up summaries of all the content that has played on a player or set 
of players across any time range. Each content item that has played during the defined view 
range will be displayed with the total number of times it has played and the percentage of 
total plays of all played content.

To view the play log summary:

1. Click Play logs in the Player Properties dialog.

2. In the Play Logs tab, select the View Range for which you would like to retrieve 
playlogs or manually enter a From and To date (“To edit the properties of a player:” 
on page 177).

3. Click Retrieve Logs.

Viewing Detailed Play Logs for a Player

In certain situations, you may want to retrieve the detailed logs for each player to review 
the exact time and reason that each piece of content played. If the content is enabled to log 
data slots, you can even view the state of any dynamic data fields at each time the content 
played.

For more information on enabling content to log dynamic data, see “Enabling Data Slot 
Logging” on page 134.

To view the detailed play logs:

1. Select the View Range for which you want to retrieve detailed playlogs or manually 
enter a From and To date (“To edit the properties of a player:” on page 177).

2. Check the Show detailed logs checkbox.
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3. Click Retrieve Logs.

Exporting Logs

Once you have retrieved play logs for a player, you can export the logs to a file.

To export play logs:

• Right-click on any column header and choose EXPORT DATA....

TIP

For more information on working with grids, see “About the Data Grid” on page 25. 

Overriding Channels

Overriding a channel is an advanced feature that provides added flexibility when sched-
uling content to play back on a player. Normally, tuning multiple players to the same 
channel will result in each player playing back the channel as it was programmed in the 
Channel Properties dialog. However, in some cases, you may want to make a small change 
to a channel on a specific player without creating an entirely new channel. For this situation, 
you can override certain properties of the scheduled items in a channel and apply them to a 
single player only.

NOTE
Overridden items are indicated in blue italic type in the channel grid.

WARNING

Channel overriding should be used sparingly, as it can cause confusion in troubleshooting 
player issues and unexpected results when editing a channel that has been overridden in 
one or more players. In most cases, you should be able to achieve your scheduling goals 
using other mechanisms available like playlists or enabling expressions.

To override the properties of a scheduled item:

1. On the Channel tab, do one of the following:

• Right-click on the scheduled item and choose OVERRIDE ITEM.
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• Double-click on the scheduled item.

2. On the Override Schedule Item Properties dialog, override any changes to the base 
schedule item. You can override the following:

• The daypart schedule for the item.

• The enabling expression for the item.

• Disable the item from playing.

You cannot change the base scheduled type of an item or change the activation or ex-
piration dates.

3. Click OK.

To clear an override:

• Right-click the overridden item and choose CLEAR OVERRIDE.
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Controlling Player Volume

You can use the Sound Control tab of the Player Properties dialog to directly set or schedule 
the overall volume of a player. The player volume settings are applied globally to all 
content that plays. If you want to adjust an individual content item’s volume relative to 
other content being played, see “Using the Content Properties Dialog” on page 118.

WARNING

You can only control the volume of SWF files that are version 8 or older. With SWF version 
9 files, it is not possible to control the player volume.

To directly set the volume of a player:

1. Click the Set Volume radio button.

2. Enter a volume for the player from 0 to 100, with 0 being no audio and 100 being the 
maximum volume.

NOTE

Setting the volume on a player volume is equivalent to setting the Master Volume in 
the Windows Mixer. The Wave Volume in the Windows Mixer will always be set to the 
maximum.

To schedule volume on a player:

1. Click the Set Volume according to Schedule radio button.

2. Do one of the following:

• Click or drag a range of cells to toggle the volume on and off for the selected time.

• Right-click on a cell or range of cells to set a specific volume level for the selected 
time.
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For more information on using schedule grids, see 19. "Using Schedule Grids", on 
page 312.

Overriding Dynamic Data Settings

Normally, when you schedule dynamic content into a channel, the content will play back 
using whatever data table bindings set during import of the content or from the Content 
Properties dialog. If you want to change which dynamic data table a content item uses for 
a specific player or channel without needing to duplicate the entire content item, you can 
override the bindings from the Scheduled Item Properties dialog.

To override data bindings at schedule time:

1. Do one of the following:

• Right-click on the scheduled item and choose OVERRIDE ITEM.

• Double-click on the scheduled item.

2. From the Scheduled Item Properties dialog, click to display the Dynamic Data tab.

3. If you want to override a binding, select a new data table to use for this scheduled 
item only. 

4. The Dynamic Data tab allows you to edit the data in a data table directly from the 
dialog. You can add or delete rows and edit data as needed.

NOTE

Edits to a data table are applied globally to the data table everywhere that it is used. 
You cannot override the values in a data table for a scheduled item—you can only 
override which data table is used. For more information on localizing data, see 
“Localizing Data” on page 217.
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5. If you want to override the master expression prescript, click Edit Prescript 
Expression.

6. Click OK.

For more information on dynamic data and content binding, see 14. "About Dynamic 
Data", on page 213.

Playing Content On-Demand (Play Content Now)

You can direct the CNM to play content on demand, even if that would require interrupting 
content that is currently playing. You can also direct the CNM to play from a playlist on 
demand.

To play content on demand:

1. In the Players page, select the player/region where you want to run the content.

2. Right-click PLAY CONTENT NOW.

3. In the Content dialog, select the content that you want to play immediately.

• If content is listed in black, it is available to play immediately.
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• If content is listed in red, it is not currently available on the Player node, and begins 
playing after the content has been transferred to the Player.

Clicking Play Next or Play Now causes the selected content to be transferred 
to the Player node.

4. Click Play Now.

The new content begins to play immediately in the selected player/region.
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You can use the scheduling grid to schedule a number of different properties of your 
CoolSign network, including any of the following:

• Dayparting a schedule item within a channel (Schedule Item Properties dialog).

• Volume level of a player (Player Properties dialog).

• Display control for a display connected to a player (Configure Players dialog).

• The hours that a site is open (Site Properties dialog).

• Bandwidth limiting for a node (Network Properties dialog). 

Working with the Schedule Grid

The scheduling grid provides a powerful interface that can be easily used for most common 
scheduling, while also providing advanced features that allow you to build very complex 
schedules quickly.

All scheduling grids share the same interface, save for a context-sensitive popup menu that 
allows you to schedule the specific values available to the property you are scheduling. 

Depending on what you are scheduling, the colors of cells indicate different values for the 
property. For properties like volume and bandwidth limiting, each cell visually displays the 
percentage level of a value (as shown above). By default, clicking a cell or dragging across 
cells toggles the cell value between the minimum or off value and the maximum or on 
value. Right-clicking on a cell or right-click dragging across cells displays a context-
sensitive popup menu to enable you to set any additional value available to that property.
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Setting a Cell Value in the Grid

Each cell in the grid has a color that indicates the value of the property at that time. The 
possible values of a schedule grid and the corresponding colors are different for each type 
of scheduling grid and are discussed in detail in the documentation for the associated 
property dialog.

You can quickly toggle the value of a cell or range of cells between the off and on settings. 
The off and on values of a property differ for each type of scheduling grid. For example, 
the on setting for the volume schedule grid indicates a volume of 100 while the on setting 
for the display control schedule grid indicates that the display’s input is set to CoolSign.

In addition to the off and on settings, some scheduling grids allow you to set additional 
values. For example, the volume scheduling grid lets you set a volume level from 0 to 100 
and the display control scheduling grid lets you set the display to any labeled input.

To toggle cells between off and on:

• Left-click a cell or left-click and drag across one or more cells. All selected cells are 
toggled based upon the first selected cell.

To set the value of a cell:

1. Right-click a cell or right-click and drag across a range of cells.

2. Select or set the value using the VALUE popup menu.

3. Click anywhere off the popup menu to close it.

Using the Zoom in the Scheduling Grid

Each cell in the grid represents a block of time during a day of the week. By default, each 
block represents a full hour during the day. You can use the zoom controls to zoom in and 
out of the scheduling grid to decrease the block of time that a cell represents so you can 
schedule at finer resolutions than on the hour.

To zoom in:

• Click  to zoom into the grid. You can zoom to the following time resolutions: 1 
hour, 30 minutes, 15 minutes, 5 minutes, or 1 minute. 

To zoom out:

• Click  to zoom out of the grid.

Overriding the Recurring Schedule

By default, when you are using the schedule grid, you are creating a recurring schedule that 
will repeat every week. If you want to modify the schedule for a specific week, you can use 
the override week features. For example, you may want to schedule displays to be on for 
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extended hours during the week before Christmas at a department store or you may want to 
disable a schedule item from playing on a certain Tuesday in November for some reason. 
With the scheduling grid override functionality, you can schedule any overrides to the base 
recurring schedule for any future week.

To select a week to override:

1. Click the Week Selector box to display the Datetime editor.

2. Use the month arrows to change the displayed month.

3. Click Today to jump to the current date.

4. Click Show Base Schedule to return to the base recurring schedule.

5. Click a day to select a week to override.

To navigate through weeks:

• Click the Forward or Back week selector buttons to move one week forward or back 
from the current week.

Use the forward and 
back week selector 
buttons to navigate.

Use the week 
selector to jump 
to a week.

Click Override Options to 
display the Override menu.

Use the Override menu to 
clear overrides or jump to an 
existing overridden week.
CoolSign Network Manager User’s Guide, Version 5.0, Issue 01 314



19. Using Schedule Grids 
Overriding the Recurring Schedule
To override the schedule for a week:

1. Edit the schedule for an overridden week using the same tools available for editing 
the recurring week as described above.

2. The overridden week is labeled as Overridden Week.

Selecting Overridden Weeks

You can quickly jump to any currently overridden weeks to review or modify the overrides. 
The Override Options menu indicates the number of weeks that are currently overridden.

To jump to an overridden week:

1. Click OVERRIDE OPTIONS to display the Override popup menu.

2. Choose JUMP TO OVERRIDE to display a submenu of any overridden weeks.

3. Choose the overridden week to which you want to jump.

To jump to the next or previous overridden week:

• Hold down the Ctrl key while clicking the Forward or Back week selector buttons. If 
an overridden week is set, the schedule grid will jump to that week.

Clearing Overridden Weeks

You can remove all the overrides applied to a schedule or just the override for a specific 
week.

To clear all overridden weeks:

• Click OVERRIDE OPTIONS and choose CLEAR ALL OVERRIDES.

To clear the override from the currently selected week:

• Click OVERRIDE OPTIONS and choose CLEAR OVERRIDE FOR CURRENT WEEK.
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This section provides an overview of what is required to play back Flash-based content in 
CoolSign. 

Preparing Flash Files

To play back Flash-based content in CoolSign, you must convert any SWF file you wish to 
use into the CoolSign content format. 

To prepare a Flash file for use with CoolSign, do the following:

1. Design your content in Adobe Flash. Include the following line of code in your 
ActionScript:

var msg:String = 
String(flash.external.ExternalInterface.call("ExpandDataSlotString", 
"$(GetDataTableAsXml)"));

This line of code retrieves the CoolSign data table that the content is bound to (or rath-
er, will be bound to at the time of playback). The data table is retrieved as an XML 
string, with elements for each row and field within the data table. For example, if you 
know that your CoolSign data table will contain a City field and a Temperature field, 
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you can expect to receive the data in the following format:

<table>

<row>

<__oid>0aca630b-ba6a-42e4-9109-a0409bae4a09</__oid>

<__seqnum>0</__seqnum>

<City>Portland</City>

<Temperature>67</Temperature>

</row>

<row>

<__oid>9b7f630b-ba6a-42e4-9109-a040910e4910</__oid>

<__seqnum>1</__seqnum>

<City>Beaverton</City>

<Temperature>69</Temperature>

</row>

...etc...

</table>

The __oid field represents a unique identifier for the row. 

The __seqnum field represents the order of the rows within the table.

NOTE

When viewing your Flash content outside of the CoolSign system (for example, from 
within the Adobe Flash designer or from a browser), this line of code will return the 
value “null”.

2. Start CoolSign Content Creator and create a new project.
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3. In the General tab of the Project Settings dialog, specify the title, layout, and 
dimensions for the new project:

4. In the Data Tables window, create or import the table structure that your content will 
use. The names that you assign to your data table fields determine the structure of the 
XML you can access from Flash ActionScript. For the example in Step 1, you would 
create two data table fields named City and Temperature, since that is what you 
designed your Flash content to expect.

5. Select the menu item ASSETS > IMPORT FILE and import your completed Flash content 
into CoolSign Content Creator. 
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6. Center and size the Flash asset to fill the Media Window.

7. If your Flash content is script-driven (as opposed to linear timeline-based), enable the 
Timeless property on the Flash asset.

8. Save the project to a folder on disk, and then close CoolSign Content Creator. 

9. Navigate to the project folder (on disk) and open the file Control.xml, using a text 
editor such as Notepad.

10.In the file Control.xml, find this line: 

</ControlInfo>

Paste the following code immediately after it. 

   <DataSlot>

      <DefaultExpression>=GetDataTableAsXml();

function GetDataTableAsXml()

{

        // load the xml values from the data table rows

        var myXml = "";

        

        for (i = 0; i &lt; myTable.Size; i++)

        {

           myXml = myXml + myTable.Row(i).AsXML;

        }

        

        return "&lt;table&gt;" + myXml + "&lt;/table&gt;";

}</DefaultExpression>

      <LogValue>False</LogValue>

      <Name>GetDataTableAsXml</Name>

      <Type>Text</Type>

      <UserProperties>

         <RowIndex>1</RowIndex>

      </UserProperties>

   </DataSlot>

11.Save and close the file. The content is now ready to be deployed using the CoolSign 
Network Manager.
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ActionScript Methods

The following methods can be invoked from ActionScript:

function CoolSignVersion() : String

Returns the name and version of the CoolSign Media Player.

var csVersion:String = String(ExternalInterface.call("CoolsignVersion"));

function GetScriptName() : String

Returns the name of the current media script.

var scriptName:String = String(ExternalInterface.call("GetScriptName"));

function GetScriptDuration() : Number

Returns the time of the current script in seconds. This value can range from 0 to GetScript-
Duration();

var scriptTime:Number = 
Number(ExternalInterface.call("GetScriptTime"));

function GetScriptTime() : Number

Returns the time of the current media script in seconds. This value can range from 0 to 
GetScriptDuration().

var scriptDur:Number = 
Number(ExternalInterface.call("GetScriptDuration"));

function ExpandDataSlotString (str:String) : String

Returns a string in which each data slot reference is replaced with the current value of the 
data slot. A data slot reference is encoded as “$(dataslotname)”. For example, the line

ExpandDataSlotString("Hello $(Name), you're in $(City)!") 

might return "Hello Bob, you're in New York!"

var msg:String = String(ExternalInterface.call("ExpandDataSlotString", 
"Hello $(Name)"));

function GetAttribute (str:String) : String

Returns a string that contains the value of the specified attribute. 

var msg:String = String(ExternalInterface.call("GetAttribute", 
"MyAttribute"));
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function GetDataTableFilename (tblOID:String, tblFilename:String) : 
String

Returns the path to a file that belongs to the given data table, usually a media file. The file 
should be considered read-only; the media player checks for changes and will not use a file 
if it has been tampered with.

var tblOID:String;  // get the oid of the table from the table?s XML

var tblFilename;    // this is the name of a file that you found in the table

var path:String = String(ExternalInterface.call("GetDataTableFileName", 
tblOID, tblFilename));

function AddRowToDataTable (params:String) : Boolean

Adds a new row to a data table. This request is sent to the Network Controller and executed 
there. If the local Agent isn’t currently connected, the requests are queued and sent once a 
connection is established. A return value of TRUE only means that the request was queued, 
not that the row was successfully added.

var added:Boolean = Boolean(ExternalInterface.call("AddRow", params));
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The params parameter is some XML that contains all the parameters to use when adding 
the row to the data table. Here is what the XML looks like:

<req>

  <DataTableID>OID</DataTableID>

  <DataTableName>SomeName</DataTableName>

  <ShouldAutoCreate>true</ShouldAutoCreate>

  <DataTableComment>some comment</DataTableComment>

  <ActivationDate>2008-01-01T00:00:00.000</ActivationDate>

  <ExpirationDate>2008-01-01T08:00:00.000</ExpirationDate>

  <RelativeActivation>0</RelativeActivation>

  <RelativeExpiration>0</RelativeExpiration>

  <BumpTableVersion>true</BumpTableVersion>

  <SequenceNumber>0</SequenceNumber>

  <Data>

    <Field>

      <Name>Person</Name>

      <Value>Tom</Value>

      <Type>String</Type>

    </Field>

    <Field>

      <Name>Score</Name>

      <Value>975</Value>

      <Type>Number</Type>

    </Field>

  </Data>

</req>

DataTableID — Required: Yes    Default: n/a

The OID of the data table to update. You must specify either DataTableID or DataTable-
Name, but not both.

DataTableName — Required: Yes    Default: n/a

The name of the data table to update. You must specify either DataTableID or DataTable-
Name, but not both.

ShouldAutoCreate — Required: No    Default: False

If TRUE, then if the data table specified by DataTableName doesn’t exist it will be 
created. This can only be used when you include the DataTableName parameter. The 
structure of the table is determined by the field information for the row that you are trying 
to insert.
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DataTableComment — Required: No    Default: “Auto-created table”

If the data table is created by this call, this parameter specifies the value to use as the 
comment.

ActivationDate — Required: No    Default: “1600-01-01T00:00:00.000”

Specifies the activation date for the data row, in the following format: “YYYY-MM-
DDTHH:MM:SS.FFF”. The default value means that the row is immediately active. 

ExpirationDate — Required: No    Default: “1600-01-01T00:00:00.000”

Specifies the expiration date for the data row “YYYY-MM-DDTHH:MM:SS.FFF”. The 
default value means that the row never expires. 

RelativeActivation — Required: No    Default: n/a

Specifies the activation date as the number of seconds from now (now being the time that 
the row is actually created in the database). This value cannot be used with the Activation-
Date parameter.

RelativeExpiration — Required: No    Default: n/a

Specifies the expiration date as the number of seconds from now (now being the time that 
the row is actually created in the database). This value cannot be used with the Expiration-
Date parameter.

BumpTableVersion — Required: No    Default: True

If TRUE, the version of the data table is incremented when the row is added. Incrementing 
the version number of the data table makes the new row visible to the media engine, so if 
you are adding multiple rows and don’t want them to become visible until all the rows are 
added, then you would set this parameter to FALSE for all the rows except for the last row 
you add; when adding the last row, you would set this parameter to TRUE.

SequenceNumber — Required: No    Default: 0

An arbitrary number that can be used to sort the rows in the data table.

Data — Required: Yes    Default: n/a

The Data section of the XML specifies the values to assign to each field of the row. It 
contains three parameters: Name, Value and Type. The Type field is only used when auto-
creating the data table and must be one of the following: Text, Number, Boolean, Date, 
Time. 
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function LocalPropertyGet () : String

function LocalPropertyGetAll () : String

function LocalPropertySet (name:String, value:String) : Boolean

function LocalPropertyIsSet (name:String) : Boolean

function LocalPropertyDelete (name:String) : Boolean

function LocalPropertyDeleteAll () : Number

Local properties are private to a single piece of content. In fact, they are local to a single 
instance of a piece of content; if a piece of content is in a schedule twice, each instance has 
its own set of local properties. 

var myValue:String = String(ExternalInterface.call("LocalPropertyGet", 
"MyProperty"));

var myProps:String = 
String(ExternalInterface.call("LocalPropertyGetAll"));

var wasSet:Boolean = Boolean(ExternalInterface.call("LocalPropertySet", 
"MyAttribute", ?Hello?));

var isSet:Boolean = Boolean(ExternalInterface.call("LocalPropertyIsSet", 
"MyAttribute"));

var wasSet:Boolean = 
Boolean(ExternalInterface.call("LocalPropertyDelete", "MyAttribute"));

var count:Number = 
Number(ExternalInterface.call("LocalPropertyDeleteAll"));
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function GlobalPropertyGet (name:String) : String

function GlobalPropertyGetAll () : String

function GlobalPropertySet (name:String, value:String) : Boolean

function GlobalPropertyIsSet (name:String) : Boolean

function GlobalPropertyDelete (name:String) : Boolean

function GlobalPropertyDeleteAll () : Number

Global properties are identical to local properties but are shared by all pieces of content. 

var myValue:String = String(ExternalInterface.call("GlobalPropertyGet", 
"MyProperty"));

var myProps:String = 
String(ExternalInterface.call("GlobalPropertyGetAll"));

var wasSet:Boolean = Boolean(ExternalInterface.call("GlobalPropertySet", 
"MyAttribute", ?Hello?));

var isSet:Boolean = Boolean(ExternalInterface.call("GlobalPropertyIsSet", 
"MyAttribute"));

var wasSet:Boolean = 
Boolean(ExternalInterface.call("GlobalPropertyDelete", "MyAttribute"));

var count:Number = 
Number(ExternalInterface.call("GlobalPropertyDeleteAll"));
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function EvalLogGet (clearLog:Boolean) : String

function EvalLogAdd (msg:String) : Boolean

function EvalLogClear() : Boolean

function EvalLogGetEnabled () : Boolean

function EvalLogSetEnabled (enabled:Boolean) : Boolean

The Eval log is used for debugging content. Messages written to the Eval log can be 
retrieved by the host application and shown to the user. 

var messages:String = String(ExternalInterface.call("EvalLogGet", true));

var msgAdded:Boolean = Boolean(ExternalInterface.call("EvalLogAdd", 
"Some message"));

var bTrue:Boolean = Boolean(ExternalInterface.call("EvalLogClear"));

var isEnabled:Boolean = 
Boolean(ExternalInterface.call("EvalLogGetEnabled"));

var bTrue:Boolean = Boolean(ExternalInterface.call("EvalLogSetEnabled", 
true));

function WriteToSystemLog (level:String, msgID:String, msg:String) : 
Boolean

Returns TRUE if the message was written to the system log. The system log is used to help 
debug issues that happen in the field.

level — The log level of the message: “Severe”, “Error”, “Warning”, “Info”, “Debug” or 
“Trace”.

msgID — Message IDs are used to track specific events without having to parse the 
message itself. Using message IDs allows you to change the text of the message and still 
allow tools and tech support to search for that event.

Message IDs should be globally unique and normally take the format <prefix><number>, 
where the <prefix> uniquely designates a particular customer and <number> is a value used 
to keep the message ID unique; for example, “Nike1001”. Spaces are not allowed in 
message IDs.

Most messages are not assigned an ID and are reported with “” as the message ID. When 
you supply a message ID, the message is also written to the application log. The application 
log is then uploaded so that it is viewable by the CoolSign operator. Since this creates 
network traffic, only very important messages should be written to the application log. You 
can override this behavior by prefixing an underscore to the message ID. For example, 
“Nike1001” is written to both the application and system logs, but “_Nike1001” is written 
to just the system log.
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msg — The message itself. This can be any arbitrary text, but it is best to include specific 
information. Generic messages are not useful when trying to track down problems.

ExternalInterface.call("WriteToSystemLog", "Info", "", "Something 
interesting happened");

function ReportError (msg:String) : Boolean

Returns TRUE if the error was properly reported. The error message is viewable by the 
CoolSign operator. After an error is reported, the AdPlayer will select another piece of 
content to play. 

ExternalInterface.call("ReportError", "I don?t want to play ***");
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Troubleshooting alerts

The Home page displays alerts that are raised by the nodes in your CoolSign network. This 
section lists some of the more common alerts and steps to troubleshoot.

Node offline 

The CoolSign node is no longer communicating with the Network Controller. 

Abnormal software restart

Either the CoolSign Agent or AdPlayer components have been restarted multiple times 
within a short period of time. This may indicate severe issues with the CoolSign node or 
software configuration. You can troubleshoot this issue by doing any of the following:

• Ensure that no one has been physically accessing the PC for maintenance or other 
reasons. 

• Review the Home page application logs to check if a user has remotely issued restart 
software component commands.

• Review the event logs for the node to determine if additional information regarding the 
software restart is available. For more information on event logs, see “About Event 
Logs” on page 302.

Unexpected reboot

The CoolSign PC has rebooted multiple times within the previous 24 hours. This may 
indicate issues with the CoolSign software or hardware problems. You can troubleshoot 
this issue by doing any of the following:

• Check that no one is physically rebooting the PC or working on the power at the 
location.

• Review the Home page application logs to check if a user has remotely rebooted the 
node.

• Review the event logs for the node to determine if additional information regarding the 
node reboot is available. 
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Not enough free space on disk

The available disk space on the hard drive of a CoolSign PC has fallen below the configured 
low disk space threshold. CoolSign automatically attempts to free up disk space by deleting 
any unused files. You can troubleshoot this issue with any of the following actions:

• Check that you haven’t scheduled more content than you have total disk space. You 
can check the total required disk space for each piece of content from the Content 
Properties dialog, and you can check the total required disk space for a channel from 
the Channel Properties dialog. If the total disk space required by a channel is too large, 
you may need to unschedule some content or upgrade your hard disk.

• Remove any other non-CoolSign applications or files that may be installed on the PC.

• Force the node to garbage collect. See“Cleaning Up Space on a Node” on page 306.

• Manually clean up the CoolSign log folders. You can delete any local log files by 
manually deleting the LogMgr folder in the CoolSign Agent folder by using the remote 
console command on the Advanced Node Properties dialog.

Display error

A serial-controlled display has reported an error or is no longer communicating with the 
CoolSign node. For more information, see “Troubleshooting display errors” on page 384.

Task succeeded/Task timed out

These alerts are raised when a task succeeds or fails within the configured time limit. For 
more information on tasks and configuration, see “Tasks” on page 310.

Troubleshooting player errors

CNM provides a number of tools to help you troubleshoot problems with your players.

Understanding Region Status

You can view the status of a player or player region in the Region Status column of the 
Players page or on the Player Properties dialog.

The status of a player can be any of the following values:
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OK—No issues have been reported and the player or region is playing its tuned 
channel correctly.

Content Error—One or more of the content items scheduled on the player or 
region reported an error during playback. For more information, refer to “Trouble-
shooting display errors” on page 384.

Offline—The entire player node is currently offline and not connected to the 
network. 

Initializing...—The player or region has just been created and is still starting up. 
This status should be transitory. If a player reports the Initializing status for more 
than a few minutes, there may be other issues with its configuration that are 

preventing it from starting. 

Paused (Display off)—Occurs when any or all of the displays connected to a 
player have been set or scheduled to OFF using the Display control. 

Paused (Display set to X input)—All the displays connected to a player are set 
or scheduled to a non-CoolSign input.

No Channel—Either a new player has not yet been tuned to a channel, or the 
channel a player was tuned to has been deleted.

Empty Channel—The channel that the player is tuned to has no scheduled items.

No Active Scheduled Items—The channel has items but none of the items are 
currently active due to pending activation, expiration, or disabling.

Unknown—No status is reported by the player. Please try restarting the player 
remotely.

No Product Key—The player does not have a valid product key. See “About 
Product Keys” on page 80.

Unsupported Resolution—A player is configured to a video output resolution 
that is not supported by the video card. Refer to “Configuring Players and Devices” 
on page 190.

Fatal Error—A player encountered a severe error that prevents it from starting up 
successfully. Fatal errors can be a result of improperly installed software, decoders 
or video drivers. In most cases, if rebooting the player does not clear a fatal error, you 

must reinstall the CoolSign software onto the player.

NOTE
Review the event logs for detailed information on the errors. It doesn't guarantee that all 
the errors have an event log entry; however, most will. For more information on event logs, 
see “About Event Logs” on page 302.
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Understanding display status

You can view the status of any display devices being serial-controlled by CoolSign in the 
Display Status column of the Players page or on the Display Properties dialog for a display.

The Display Status of a player can be any of the following values:

(blank)—This player is not configured with any display control. The player cannot 
retrieve status from any connected display devices.

Display OK—The display device is reporting an OK status to the player and is set 
to the configured CoolSign input.

Display OK (Set input is XXX)—The display device is reporting an OK status 
and its display control has been directly set to the indicated input from the Display 
Properties dialog.

Display OK (Scheduled input is XXX)—The display device is reporting an OK 
status and the current input is set to the indicated input as defined in the display’s 
input schedule.

Waiting for status on new display—Newly configured displays will report this 
status until the display device first reports its status to the player.

No Connection—Indicates that the display device configured for this player is not 
reporting any status to the player. Refer to the following discussion, “Trouble-
shooting display errors” on page 384.

Unknown (Offline)—The player is currently offline and the current display status 
cannot be determined.

[Error status]—Any other status values are reported directly from the display 
device and are dependent on the error messages for that device.

Troubleshooting display errors

Unfortunately, providing an exhaustive resource on troubleshooting every possible make, 
model, and configuration of display device is beyond the scope of this document. If you are 
getting a No Connection display status for a display you believe to be connected, you 
should check the following conditions:

• Confirm that the display properties match the actual display device. Both the brand and 
model must match the actual device exactly. 

• Confirm that the display is configured to use the correct COM port.

• Verify the display is receiving power and shows a signal with the OSD.

• Check that the serial cable is securely connected to both the player PC and the display 
device.

• Verify that the serial cable is not defective by using it on another player that is already 
working or by doing a continuity check on all pins.
CoolSign Network Manager User’s Guide, Version 5.0, Issue 01 384



D. Troubleshooting 
Reviewing audit history for an item
If you are receiving a display-specific error status, please check with the manufacturer’s 
documentation provided with your display device.

Reviewing audit history for an item

When troubleshooting problems with your CoolSign network, it can be useful to review 
exactly what actions were performed on an item. The item audit history lists every change 
made to an item, when the change was made, and which user made the change. You can 
review the audit history for the following items in your network:

• Content

• Audio

• Data Tables

• Channels

• Playlists

• Nodes

• Triggers

To review the audit history for an item:

1. Open the properties dialog for the item you want to review.

2. On the Security tab, click Audit History to open the Audit History dialog.
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3. Click in the Data column to view which fields were modified on the object.
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